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About the application
Business Processes

Welcome to Business Process Modeling

The application approach to integration centers on business process management. Business process
modeling is the foundation of the configurability and extensibility of the application Using the application,
you coordinate and automate the activities that make up the processes your company completes to do
business. From advanced file translation and transport to content-based routing and complex integration,
including human interaction, you can configure the activities you need using the application business
process modeling features.

About Business Processes

In the business world, a business process is any goal-driven, ordered flow of activities that accomplishes a
business objective. Invoicing, order fulfillment, and updating employee information are all examples of
business processes. In the application, business process refers to the automated implementation of business
objectives.

Most processing activities of the application are predicated upon defined business processes—the
custom-designed programming instructions you provide to the application, to perform your required
activities. The fact that you can custom create business processes in the application means that you control:

What happens when

Which the application components perform the activities

What rules, constraints, or decision points play a role in the execution of the activities
The degree of available visibility into processing

R R

The amount and type of data the system records about the activities

The application components and features are designed to provide a variety of options for configuring your
activities. As a result, you often have multiple choices available when determining how to achieve a given
goal. With so many choices, you can create business processes that are expressly suited to your
organization’s requirements—not only to complete the required work, but also to maximize processing
efficiency for all of your processes, streamline your ongoing maintenance tasks, and facilitate monitoring
and tracking operations.
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For example, some of your processes may require quick turnaround, while others may involve batch
processing not tied to a time limit. You can configure efficient processing of both types of processes by
running low-priority batch processes during slow periods, which frees system resources for the
higher-priority items that run immediately. Customizing your processing activity for maximum efficiency
keeps system resources available for enhanced management options such as archiving, data persistence and
document tracking.

Business Process Models

The application allows you to create an automated business process using drag-and-drop technologies to
link activities in a digital, graphic representation of the related task—known as a business process model.
The business process model is the definition for the process, used by the application each time it runs the
process. The activities in your business process models are carried out by services and adapters, represented
by icons in the graphical interface. This method enables you to incorporate small units of reusable code into
your business processes, and, at the same time, create larger units of reusable code specific to your business
operations.

Creating business process models is the central endeavor around which your use of the application hinges.
Think of business processes in the application as the structures by which you organize software components
and activities to fulfill your work objectives.

Benefits of Business Process Modeling Flexibility

Your business processes and the efficiency with which they progress are the key to your organization’s
success. To be competitive, you must be responsive to constant change within your trading partner
community. Changes driven by new requirements such as new data formats and communication protocols,
new business exchanges, and a broad range of partners varying in size, type, and sophistication, mean your
organization must be flexible enough to adapt quickly and efficiently.

By integrating activities through automated business process models, all in the form of easily reusable code,
you increase the value of your e-business operations. As your needs change, modifying your business
process models to keep pace is simple.

Support for Business Process Modeling

The application components and tools are designed to support the full range of standards, foreign languages
and data types, in a user-friendly fashion.

Graphical Process Modeler

The graphical modeling tool (the Graphical Process Modeler, or GPM) that enables you to create business
process models using a visual, drag-and-drop palette, converts your graphic business process models into
code, saving you the effort of writing code. Your process models are immediately executable, and the
process development cycle time is short.
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The primary benefits of business process definition using the model format are that you do not need direct
developer involvement, you can create your models in a visual medium, and you can copy any business
process model or portion of a model to use it in another process, eliminating the need to duplicate effort.

Standards, Foreign Language and Data Type Support

The services and adapters provided with the application are developed using publicly agreed-upon
specifications for data formats, communications protocols, workflow modeling, and security to maximize
interoperability between systems and trading partners.

The application code base supports universal character-encoding, therefore, programs with which your
business processes interact can be written in nearly any language. And the application supports virtually any
file-, message- or stream-based data type.

Available Service and Adapter Components

The application provides more than 200 available services and adapters you can build into your business
process models. This includes a host of configurable adapters ready for use in business processes for
activities such as running legacy programs, ERP systems, Perl scripts, Java™ code, decision engines,
defined subprocesses, or virtually any program.

Adapters provide noninvasive integration with ERP, Supply Chain Management, Customer Relationship
Management, other packaged applications, legacy applications, communications protocols, queuing
solutions, and databases.

Support for High Volumes of Transactions

Depending on your task (for example, translation and routing, content-based routing, or EDI inbound or
outbound transactions), and the standard in use (X12, EDIFACT, and so on) you can process anywhere from
hundreds of thousands to millions of transactions per hour according to the business process models you
create. The application provides a variety of adapters designed to support high-volume processing.

Visibility Into Process Activities

The application enables you to view general and detailed processing information for active and recent
business processes and service activities. Because the application interoperates with other enterprise system
management products, you get full-spectrum transaction visibility.

In addition to process data, you can enable document tracking for a business process so that the system
carries tracking information with the document, and then, for monitoring and tracking purposes you can:

4 Track processing history of the document
4+ View transaction details related to the document
4+ Obtain processing state information related to the document

Portlets in the application dashboard interface enable at-a-glance monitoring of your processing activities,
and you can configure custom reports related to the operations undertaken by your business processes.
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What Kinds of Things Can Business Processes Do?

The strength of using the business process approach to integration is enhanced efficiency through
automation, combined with simplified configuration of integration tasks.

Automation and Integration

Any time you can replace manual intervention points in your business processes with automated
capabilities, you save money. Classic examples of intervention points include exception management such
as escalation and transaction reconciliation, error handling, and content-based routing.

The application business process modeling supports your end-to-end integration goals by enabling you to
link vital systems and processes using services, adapters and human interaction points that you need to
achieve your business objectives. You can embed conditions within the process flows.

The following figure shows the application integration engine coordinating communication of data to
trading partners. Business processes related to this scenario might involve:

4+ Transforming data (using services) from different applications so that it can be communicated to other
systems.

4+ Moving and communicating data between different systems external to the application, using adapters.
4+ Communicating data to trading partners, using adapters.

SAP R/3
System
Gentran IBM
Integration WebSphereMQ
Suite 3 ¢ Messaging
Business System
Process
ammunicat) Engine
Adapters
Tradina
HadHhg
Partners
Relational
Database
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Examples

The following table provides examples of how business process models can help you to automate and
integrate your activities:

Type of Activity Example Business Process Activities

Automating ¢ Route messages according to their content.
¢ Configure mailbox store-and-forward services.
¢ Support real-time request and reply processing within a process.
¢ Build on-fault processing steps into your process models

¢ Send alerts and natifications automatically within a process.

Integrating ¢ Incorporate messaging, human interaction, and file and database activities (a set of
services, called human interaction services, enable people to interact with a business
process). For instance, a worker can use a Web browser to send a message, as a
step in a business process. When the message is sent, the business process
continues. The process could be configured to both send the message and store a
record in a database.

¢ Set up self-service access to information across trading partner systems.
¢ Integrate with SNMP network management, LDAP directories, and Web services.

¢ Integrate with diverse operating and ERP systems.

Automating and ¢ Incorporate XML, EDI, and proprietary file translation, transformation and filtering.

Integrating
¢ Facilitate e-business with your trading partners for a vast assortment of transactions,

including EDI, e-mail, data publishing, and reliable bulk file management.

¢ Automate the integration of batch, synchronous, and asynchronous applications. For
instance, you can integrate a legacy inventory management system with your front
office Web-based order processing and accounts receivable invoicing systems.

¢ Support multi-party collaboration work processes for the entire document life cycle.
For instance, you can route data through a series of review-and-approval steps,
allowing data modifications to be made by the reviewing parties along the way, and
the reviewers could be using disparate systems.

¢ Synchronize data in different internal applications or between your organization and
your trading partners.

Business Process Concepts

In the application, a business process is a series of linked software and possibly human activities that
accomplishes a business goal. The activities in a business process are primarily performed by components
known as services and adapters, and are orchestrated by the application integration engine.

The Business Process engine runs business processes according to the instructions that comprise your
business process models. Technically, a business process model is defined by a single, unique BPML
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document, a .bpml file. BPML is an XML-based language used to describe (model) and run business
processes.

Business process models are the executable tasks and instructions that make up processes. The Graphical
Process Modeler, or GPM, enables you to create business process models by manipulating icons that
represent services, adapters, and other specific instructions, in a graphical palette. The GPM converts the
graphical representation of business processes to BPML behind the scenes.

The following diagram illustrates a simple business process model as it displays in the GPM:

This example is one of the predefined business process provided for your convenience with the application
(this is the EDI deenveloping business process). The following figure illustrates the BPML code that is
created, stored and used by the application for a business process model:

<process name="EDIDeenvelope">
<sequence>
<operation>
<participant name="EDIDeenvelope"/>
<output message="Xout">
<assign to="." from="*"></assign>
</output>
<input message="Xin">
<assign to="." from="*"></assign>
</input>
</operation>

</sequence>
</process>

For more information about predefined business process models, see:

4+ Reusability of Business Processes
4 Using Predefined Business Process Models
4 Subprocesses

Subprocesses

Any business process can be a subprocess. The term subprocess indicates a business process that is invoked
as part of another business process (the initiating process is called the parent process). Subprocess is an
integral concept in the application, because building a business process once, but using it as a subprocess in
multiple other business processes, simplifies future maintenance.

When you modify a process model that is called as subprocess by multiple business processes, you make
one set of modifications — in the subprocess — but all of the parent business processes use the updated
subprocess when they run.
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In this way, subprocesses work with the design concept of reusability; by identifying simple units of work
that appear in more than one business process, and designing your subprocesses to be as generic as possible,
you can save a great deal of time. The following illustration shows how a subprocess fits into a larger
business process model:

Inbound order
initiates Process A

e

Translation Hand-off to
Receive Order »! Sort Order Sl
Needed? .

Processing

Process A: Customer Order Process

Process A determines translation is
needed and initiates Process B

Process B: Order Translate Order

Translation Sub-Process

Reusability of Business Processes

Reusability is the concept related to creating business processes that can be used in multiple operations.
Reuse is beneficial both for uniformity, which aids in troubleshooting and monitoring, and for efficient
maintenance of your processes. For example, if you use a single business process model as a subprocess
within many larger process models, any time you need to modify the activities in the subprocess, you need
only update one model, and the changes are reflected everywhere the process is used.

Predefined Business Process

A predefined business process is a business process model that is provided with the application and is ready
to use upon installation of the application, with minimal configuration required. A variety of predefined
business processes are available for your use. For additional information, see Using Predefined Business
Process Models.

Business Process Instance

Because a business process model is the definition of a process, each time the application executes that
specific set of instructions, it runs what is referred to as an instance of the business process defined in the
model. This distinction enables you to differentiate between multiple executions of the same business
process model, which is imperative for monitoring and troubleshooting your processing activities. The
application identifies each instance with an instance ID in the interface.
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Service Configurations in Business Process Models

Services and adapters are software components that do work (adapters are a type of service). Business
processes call services and adapters to do this work, but you must configure them for use before you can
include them in your business process models.

Services exist on two levels in the application: as service types and service configurations. Service types are
the services installed with the application—these are service definitions provided for you to copy and
configure according to your needs.

The act of copying and configuring a service type creates a service configuration. You must create service
configurations in order to use services with your business processes. A service configuration is a unique
definition of a service or adapter type for which you have specified specific parameters. When you create a
service configuration, you save it with a unique name.

Business Process Version

Before using business process models, you must check them into the application, which saves a copy of each
file you check in. A business process version is one of these copies of a business process model checked in
to the application. The saved versions enable you to revert to using an older copy of a business process
model if the need arises, and to compare different iterations of your process models.

Business Process Model Components

When you create business process models, you link the application components needed to carry out the
required tasks for your business objective, creating a graphical representation. All components are
represented by icons in the GPM. The following table describes components used in business process
modeling:

Business Process Description
Component
Service A component you can configure in a business process to carry out an activity. The

Translation service, for example, performs data translation within a business process.

An adapter is a type of service that communicates with external systems to move data in
and out of the application. For example, you can use the File System adapter as part of a
business process to collect files.

Adapter See Service, above.

BPML activity Performs a BPML function. BPML activities enable a business process to perform an
operation (such as invoking a service), providing control of the flow of data through a
business process.

Think of BPML activities as instructions built into a process. The BPML activity called the
Choice activity, for instance, allows you direct the flow of data in a process into different
activities according to the result of a decision. For example, you can create a decision point
that routes high-volume invoices to a manager while passing smaller invoices on for
immediate processing.
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Business Process Flow

The application architecture centers around the execution of individual services according to your process
models. At the core of the system architecture is the integration engine, which executes the services and
adapters needed to achieve your business goals and enable visibility into processing activity. Each step in a
process model either initiates an activity in the process flow, is initiated and runs during a process flow, or
ends a process flow.

The application may start business processes in different ways:

4 According to a user-defined schedule

4+ Inresponse to an activity, such as the placement of a file into a specified folder (you can configure a
single input adapter in the application to work outside of a business process and to dynamically select
the appropriate process to start when it receives a file)

4 A user manually starts a process

At each step in a business process, the integration engine calls the indicated service and one of the following
ensues:

4 Services run within the application.
4+ Adapters call third-party applications to perform activities outside of the application.

4+ BMPL activities configured in the business process model provide instructions to the integration
engine regarding the process flow, such as start and stop, assign a specified value in the process data,
run specified activities simultaneously, and so forth.

When an activity completes, the integration engine progresses to the next step in the business process.

At each step in a business process, the application saves a copy of work flow context (WFC) data, which
records the state of the business process from service to service. The WFC contains the document being
manipulated by the business process and is where each service reports any errors.

Flow Complexity

A business process can flow as a simple linear configuration or contain one or more:

4+ Decision points requiring human or system determination of the next steps in the process
4+ Subflows or nested activities

4+ Loops (repeating activities)

An example of a simple business process is fire-and-forget publishing of a business event to a group of
interested participants. The steps in the process would be triggering the process and the subsequent
publishing of the event to the interested parties.

A complex business process might require multiple interactions among many applications in a
start-and-stop, request-response mode, along with human interaction, occurring over a long period of time
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The following figure illustrates the tasks in a simple process containing a decision point (a diamond
represents a decision point):

Process Request

PO Received

Send to Manager

In this figure, the business process may include the following activities:

1. Receive a purchase order (PO). In a likely usage scenario, the application receives the document
through an adapter configured to operate outside the context of a business process. According to the
content of the document, the application determines which business process to start and starts the first
service in the process by placing the message or document and other appropriate process state
information on a queue for the appropriate service in the selected business process.

2. The appropriate service retrieves the initial business process state information from the queue (PO
Received, in the figure depicted above) and processes the next step in the business process.

3. A service, according to rules assigned to a Choice activity in the business process model, reviews the
PO amount to determine whether the PO is more than or less than $500.

4. If the amount is less than $500, an adapter sends the modified business process state information, with
the data, to a specific application for PO request processing (this likely involves initiating another
process).

5. If the amount is greater than $500, an adapter sends the modified business process state information,
with the data, to a specific application or human interaction service for a manager to further review the
request.

For more information about structuring business process models, see Organizing Your Business Process
Models on page 27.

Business Process Management Activities

Single business process models generally represent only a portion of an entire business process solution.
Typically, users configure multiple business process models to work together to accomplish each business
goal. The application is equipped to manage complex operations, but following good design and
maintenance practices also helps to ensure that the application is optimized for best performance.

Because business process models are likely to have decision points and interrelated subprocesses, creating
business process models may be complicated by the need to manage many business processes at the same
time. Often, a business process shares aspects of other business processes, such as access to the same
software applications, use of the same B2B processing standards, and use of the same resources in the
application.

Managing your business process models involves the following tasks:
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Planning the most efficient processes to achieve your business objectives

Determining the application components needed to complete the tasks in the processes
Configuring business process model components

Creating business process models

Testing process models

Implementing your business process models in the application

Modifying business process models as your changing needs require them to grow, shrink, change,
merge, and split

Keeping records of the process models you create, use, and modify, for reference

Your business process models are the application resources, meaning, you can save them to an offline
directory and import and export the files as needed from one copy of the application to another.

Your business process management goal is to maximize the usefulness and efficiency of the process models
you create, while minimizing the work involved in creating and maintaining them. To help minimize set-up
time, the application includes a number of predefined business process models that you may be able to use.
In addition, follow the application best practices for business process creation so that your processes run at
the maximum system performance possible for your activities.

For detailed information about planning and creating your business process models, see Planning Your
Business Process Models.
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Introduction to Planning Process Models

Careful planning is the key to developing business process models that both process efficiently and
minimize your ongoing process model management efforts. Understand your business problems in detail
and prepare to invest the bulk of your effort in process planning and collecting related information. This will
make creating your business process models easier.

Much of your research may already be complete. When you outlined your implementation of the
application, you most likely worked with Sterling Commerce Professional Services to create an
architectural design plan detailing the ways you intend to use the application, and the associated components
and features you will employ.

Many of the details of your architectural design plan describe the business process models needed to
automate the execution of your processes. Use that information as you progress through the business process
planning steps provided in this documentation.

How to Approach Business Process Planning

Essentially, when you create business processes, you are programming the application to execute your
desired activities. The application makes your tasks easier by providing preconfigured services, adapters,
Web templates, and the Graphical Process Modeler tool. However, the following development tenets should
be the foundation of your business process modeling strategy:

4+ Uniformity and reusability

Approach the creation of all business process models in the same way, with a focus on maintainability.
A uniform modeling approach increases your opportunities to reuse processes and parts of processes
throughout your implementation, and streamlines ongoing management of your process models as
your needs change over time.

For more information about the concept of reusability and other terms related to business process
modeling, see Business Process Concepts on page 11.
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Performance

Understand how your implementation is designed so that you do not create process models that hinder
performance. Your goal is to maintain acceptable levels of functionality and performance as the
amount of work being performed in the system increases.

As you develop your business process models, you may discover more efficient ways to perform a
required task. For example, depending on the complexity and size of your documents, in some cases it
may be faster to use an XML Encoder service instead of a full translation solution.

Familiarize yourself with the application performance and tuning recommendations and techniques
and build business process models that do not unnecessarily tax your system. Determine how much
business data you will need to keep in your active system, and set up your processes to only save
needed information. Follow the best practices for business process models.

Technical knowledge

Be familiar with the software applications, standards, security, and performance requirements that are
related to your integration needs, or have personnel resources available who can help. As you
configure the activities within your process models you will need a great deal of technical information.

Business process models in the application are created in BPML code. A basic understanding of this
format will help you work with business process models.

Periodic review

Periodically, review the construction of your business processes to confirm that they meet your reuse
and performance requirements, and make adjustments as needed.

After designing your initial processes, you may find that you can consolidate and trim the process to
gain efficiencies.

Business Process Model Planning Stages

The following table lists the phases of business process development, with a link to detailed instructions:

Stage  You must identify: For details, see:
1 Your business needs Identifying Business Needs on page 20
2 The separate activities that make up the process of Identifying Activities in a Business Process on
fulfilling your business needs page 20
3 Logical and manageable groups of activities within Identifying Subprocesses on page 21
the process that can be developed as subprocesses
4 Steps where the process can be automated Identifying Opportunities for Automation on page
23
5 Integration points between steps Identifying Integration Points in Your Process on
page 24
6 The most efficient structure for your business process Organizing Your Business Process Models on

model page 26
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Stage  You must identify: For details, see:
7 Your needs for visibility into active and completed Maximizing Visibility Into Business Processes on
process activity page 28

In creating your architectural design plan, you may have completed some of these stages for all or some of
the process models you will create.

The topics describing each of the planning stages provide details, instructions, and an example process that
continues from stage to stage. Proceed through the stages in sequence for the complete planning process.

Remember that the information provided here may not apply to every scenario; consider it a general baseline
for all scenarios.

Identifying Business Needs

Identifying your business needs consists of noting each business problem, goal, or scenario, and the related
progression of actions required to resolve it. For example, if your business need is to process customer
orders, you might note the following actions:

1. Receive order.

Route order to appropriate departments for processing.
Fulfill order.

Generate data for invoices.

Update inventory records.

© 0 kM N

Generate invoice statements.

The following illustration shows a sample depiction of the business need and its related actions :

1 2 3 4 5 6
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When you have completed this stage, move on to Identifying Activities in a Business Process on page 20.
This documentation uses the Customer Order Processing scenario throughout the remaining stages.

Identifying Activities in a Business Process

After you have outlined a business need and the steps that fulfill it, you must identify in detail the activities
within each step that enable the process to move forward.
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For example, the following table identifies the activities in each step of the example process for Customer
Order Processing (see Identifying Business Needs on page 20):

Step Description Activities
1. Customers order merchandise by sending ¢ Orders enter system through a communications
Order EDI documents. adapter for HTTP, AS2, or FTP, or through the EDI
Entry VAN.
2. Translate and forward order data. ¢ EDI translator translates EDI document into order
Order processing system format.
Processing ¢ Order documents are sent to the order processing
application.
¢ Picktickets are produced and sent to warehouse.
¢ Order processing application sends shipping
information to order fulfillment department.
3. Workers fulfill orders and initiate ¢ Orders are picked.
Order record-keeping. o o ] )
Fulfillment ¢ Shipping records and pickticket information sent to
data processing.
4. Data for filled orders recorded and * Order data updated.
Data transmitted. _
. ¢ Invoice data generated.
processing
¢ Data sent to Accounts Receivable application.
¢ Data sent to Inventory Control application.
5. Inventory data processed. * Inventory control system records updated.
Inventory o o
control ¢ Process for augmenting inventory may be initiated.
6. Invoice processed. ¢ Accounts Receivable system generates invoice
Accounts statements.
receivable ¢ Invoices translated to EDI.
.

Invoices sent to customers through communications
adapters.

After you have outlined the activities within your process, proceed to Identifying Subprocesses on page 21.

Identifying Subprocesses

Remembering that the concept of reuse is the key to efficient ongoing management of your business process
models, you must now take the time to identify possible subprocesses in your scenario (for information
about the concepts of reuse and subprocesses, see Business Process Concepts on page 11).

Sterling Commerce, Inc.
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Examine the outline of business process activity details you created in Stage 2, and look for logical,
manageable groups of activities that you can create as separate subprocesses. Aim to create distinct process
models for each subprocess within your overall scenario. You can then configure a parent process model
that links the subprocesses.

Also consider whether any predefined business process models provided with the application, or other
business process models you are creating for your organization, perform activities that make up parts of your
processes. If they do, you can use them as subprocesses. For information, see Using Predefined Business
Process Models on page 30.

A group of activities may be well-suited to configuration as a subprocess if any of the following are true:

4+ Together they accomplish a single unit of work.
4 The activities are generic enough to reuse.
4+ The subprocess can be invoked in a generic way, which increases opportunities for reuse.

For example, rather than building a situation-specific process model that uses a certain map according
to hard-coded parameters in the process model, include the Typing or Lookup service to determine
which map to use.

4+ The activities are bracketed by a pair of related BPML activities (such as Sequence Start and Sequence
End) or work within a specific business model. For example:

+ Request/Response
+ Produce/Consume

For information about BPML activities, see Organizing Your Business Process Models on page 26 and
the application and BPML.

Subprocess Example

Step 2 in the example Customer Order Processing scenario (see Identifying Activities in a Business Process
on page 20) consists of the following related tasks that together comprise a likely subprocess:

4 Orders are translated into a format the order processing system uses.

4+ Order documents are sent to the order processing application.

4 Picktickets are produced and sent to warehouse.

4+ Order processing application sends shipping information to order fulfillment department.

These activities comprise one unit of work, may be reused, and different adapters can call this process to
initiate translation.

After you have determined which processes and subprocesses to create, proceed to Identifying
Opportunities for Automation on page 23. You must complete the remaining stages for each process and
subprocess you will create.
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Identifying Opportunities for Automation

Now that the business process, its steps, and the activities within those steps are defined, you must consider
process automation. Process automation means running each step of a business process with little or no user
intervention. The application provides a host of components designed to enable you to automate the bulk of
your activities.

Highlighting Manual and Automatic Activities

Answer the following questions to determine which steps and activities in a process can be automated:

4+ Which steps of the process should run without user intervention or attention?
4+ At what step or steps in the process is human interaction necessary?

4+ At what step or steps is it necessary for the application to convert the document to the structure
required by another system?

4+ What is the best method for starting the process?
4+ Do any of your applications need to process documents as soon as they are received?

4+ Should your applications send documents to a specified location or process when processing is
complete?

Example Process with Manual and Automatic Activities

The following table shows activities in the example Customer Order Processing model (see Identifying
Business Needs on page 20) could be automatic and which could be manual:

Step Activities

1. Order entry ¢ EDI orders enter system through the EDI VAN or communications adapter
(Automatic).

2. Order processing ¢ Orders are translated into a format the order processing system uses (Automatic).
¢ Order documents are sent to the order processing application (Automatic).

¢ Picktickets are produced and sent to warehouse (Automatic).

3. Order fulfillment * Orders are picked according to pickticket print-outs (Manual).

¢ Workers scan each item picked into a hand-held scanner, routing data to inventory
control and order system for updates (Manual and Automatic).

¢ Shipping records and pickticket information sent to data processing (Automatic).

¢ Exceptions process started if needed (for example, item not on shelf, backordered,
etc.) (Automatic).
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Step Activities

4. Data processing # Order data is updated (Manual).
¢ Invoice data is generated (Automatic).
¢ Data sent to Accounts Receivable application (Automatic).

¢ Data sent to Inventory Control application (Automatic).

5. Inventory control ¢ Inventory control system records updated (Automatic).

¢ Process for for augmenting inventory may be initiated (Automatic).

6. Accounts receivable ¢ Accounts Receivable system generates invoice statements (Automatic).
¢ Invoices translated to EDI (Automatic).

¢ Invoices sent to customers through communications adapters (Automatic).

When you have noted the automatic and manual activities within your process, proceed to Identifying
Integration Points in Your Process on page 24.

Identifying Integration Points in Your Process

Integration points are points at which documents within your process move from one system or application
to another.

Identifying these points helps you to pinpoint the technological requirements related to your process model,
which you need to know before you can configure the appropriate components to execute the work. Be
specific in naming the applications that must be integrated.

Communication Adapters for Integration

Adapters perform activities that control the transmission of business process data between the application
and external applications. For example, in a customer order process, you can use adapters that enable the
application to move documents from the order processing system to the accounts receivable system. The
documents first go through a translation step so that they are in a format that the accounts receivable system
can use.

Carefully consider which external applications and systems you need to have communicate within your
process model, then review the adapters the application has available to find the adapter that fulfills your
need. If necessary, you can also create custom adapters using the Service Software Developer’s Kit (SDK).
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Example Integration Points Table

The following example table identifies the activities in which documents move from one system to another,
within the example Customer Order Processing process (for information, see Identifying Business Needs on
page 20), but this table does not name specific applications, as you should do for your actual plan:

Step Activities Integration Points/Adapters
1. ¢ EDI orders enter system through Receipt through bootstrap adapter such as the
Order entry communication adapters or the EDI VAN. File system adapter or an HTTP, AS2, or FTP
adapter.
2. ¢ Orders are translated into a format the Translation from incoming EDI format into the
Order order processing system uses. format for:
processing .
¢ Order documents are sent to the order ¢ The order processing system
processing application. * Any backend system for storing order entry
* Picktickets are produced and sent to records to which the data may be routed
warehouse. ¢ Any other systems used for tasks such as
credit checks, approvals, etc.
¢ Pickticket system
For example, translation may involve an incoming
EDI 810 being transformed into an SAP IDOC.
3. ¢ Orders picked. ¢ Humans interact with pickticket data to fulfill
Order . . . orders. Use human interaction service to
fulfillment Items scanned for data routing to inventory : e
display pickticket data.
control and order system.
¢ Shipping records sent to data processin * Resume automation when humans
pping P g electronically send shipping records to data
processing systems. This involves
adapter/translation steps from scanner data
entry format into the format for other systems.
4. ¢ Order data updated. ¢ Use B2B adapters such as the AS2 adapter,
Data SOAP adapter, or HTTP and FTP adapters, to
; ¢ Invoice data generated. peer, . (|- adapters,
processing 9 send data to appropriate applications and
¢ Data sent to Accounts Receivable initiate steps 5 and 6.
application.
¢ Data sent to Inventory Control application.
5. ¢ Inventory control system records updated. ¢ Bootstrap adapter, such as the HTTP Server
Inventory initi
control + Business process for for augmenting adapter or FTP Server adapter, initiates
. - inventory-related process.
inventory may be initiated.
6. ¢ Invoices are processed.
Accounts
receivable ¢ Statements are produced.

After you have completed Stage 5, you are ready to plan the best structure for your process models. Proceed
to Organizing Your Business Process Models on page 26.
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Organizing Your Business Process Models

Using the GPM to create your business process models is simple to do, but requires some knowledge about
structuring the physical design of your process models in a way that makes them easy to understand and
maintain. In addition, your process models must use specific BPML activities in circumscribed ways.

BPML Activities Requirements

To construct viable business process models using the GPM, you must use certain BPML activities
according to requirements related to their placement in your process models. Some activities must be used
in pairs, to bracket other activities. That is, for a given activity, you must use one of these bracketing, or
parent, activities at the beginning and one at the end. For example, before a series of activities in a business
process model that you intend to run simultaneously, you must include the All Start BPML activity, and
after the series, you must include the All End activity. For a complete list of available BPML activities
depicted in the GPM, and the requirements related to using them, see BPML Activities in Business Process
Models on page 33.

Organizational Concepts

The following table outlines concepts and structural elements related to designing business process models:

Concept or Description When to use
structural element

Subflow A subflow is a subset of activities in a Use subflows to streamline the display of your
business process model. In the GPM, a process model in the GPM by organizing a
subflow is represented as an icon in the logical subset of activities in a single layer of
process model. You add the subflow icon to the process model. This facilitates easy
your process model and then define the navigation among the separate parts, or layers,
components of the subflow. The subflow is  of your process model, while providing a
invoked in sequence during process simpler visual display of the process as a whole
execution. Also see Layer on page 27. at the parent-layer level.

Subprocess See Subprocesses on page 12. Invoke See Identifying Subprocesses on page 21. For
subprocesses from within a business help determining whether to use Spawn or
process model using either the Invoke Invoke Subprocess to invoke a subprocess,
Subprocess service (sometimes called refer to the following tips:

Invoke Business Process service) or the

Spawn BPML activity ¢ The Spawn activity asynchronously initiates

another business process.

¢ The Invoke Subprocess service, as the
application service, is not portable to
another BPML implementation, whereas
Spawn — a standard BPML activity — is.

¢ Invoke Subprocess offers multiple
configuration options, such as the ability to
invoke the subprocess synchronously, run it
inline, and so forth, that Spawn does not.
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Concept or
structural element

Description

When to use

Layer

Layers are subflows contained within the
business process model. The GPM enables
you to chunk subsets of your business
process model components into subflows,
to streamline the depiction of the parent
process’ flow in the GPM workspace. You
can display the subflow activities in a
separate workspace.

Use the Layers tab in the GPM for easy
navigation between the parent flow and any
subflows.

Node

Each activity depicted in a business process
model in the GPM is a node. You can view
an alphabetical list of the nodes in each
layer of a process model.

Use the Nodes tab in the GPM for easy
navigation when viewing and modifying the
activities that make up the layers in your
process models.

Decision point

Activity in a business process model at
which defined rules specify the processing
activity or path to take. This activity is
depicted by the Choice BPML icon. The
Choice activity is a parent activity to child
activities that it initiates.

For more information, see Decision Points
and Rules in Business Process Models on
page 32.

Include a decision point in a process model at a
point where the continuation of the path must
be determined according rules you define. The
decision point can involve selecting one of two
or more possible paths, or it may be part of a
linear process that continues according to a
rule.

Rule Rules are directions you define at a decision Use with Choice BPML activity for complex
point in a process to determine the activities that require selection of one of
processing path. multiple alternate activities. For more

information, see Decision Points and Rules in
Business Process Models on page 32 and
Defining and Assigning Rules and Conditions
on page 44.

Loop A flow, typically a subflow, within a business Use when you need an activity to repeat. The

process model that repeats itself.

Repeat BPML icon initiates the loop.

Child activities

Activities preceded in the business process
model by a specific, structurally required
BPML activity, such as Choice Start,
Sequence Start or All Start.

Review the BPML activities descriptions for
information about how to structure parent-child
relationships in business process models. See
BPML Activities in Business Process Models on
page 33.

Parent activities

Activities in the process model that initiate
child activities. For example, Sequence
Start is a parent BPML activity to the
services that follow it.

Review the BPML activities descriptions for
information about the parent activities to use so
that your models process correctly. See BPML
Activities in Business Process Models on page
33.

OnFault

A BPML element you use to configure error
handling in your process model. OnFault
activities are associated with other
individual activities.

Include OnFault activities when you need to
enable a specific activity in a business process
to recover from faults and allow the process to
continue. An OnFault Group is a subflow.
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Using Adapters to Start Business Processes

Some adapters can dynamically select and run business processes. These are known in the application as
bootstrap adapters. These are generally input adapters, such as the File System adapter, Command Line
Adapter 2, and FTP Client adapter.

When you plan your business process models, use bootstrap adapters to run independently of the process
model and then dynamically start the process whenever possible. This strategy encourages reusability,
which is one of the best practices recommended for creating your business process models.

Using a bootstrap adapter involves configuring an instance of the adapter, in which you indicate the business
process it starts. You can also configure a schedule for running the adapter. For example, in a
translation-related process, you can use different configurations of the File System adapter, set up to poll
different folders on systems for data input from different places, in different formats. Then, configure your
business process model so that the different configurations of the adapter can call and start the same process
to translate their data; the translator step determines on the fly which map to use to translate the format of
the data it received.

Tying It Together

A good starting point for organizing a process model is the simple linear progression of activities that forms
its basis. From there, add decision points, loops and subflows as needed, configure any activities that initiate
subprocesses, and add OnFaults where appropriate. You might also find Xpath expressions and nhame-value
pairs to be useful in the construction of your process models. For more information, see Assigning
Name-Value Pairs in a Business Process Model on page 46. Always remember to follow the best practices
for business process models.

When you have planned the structure of your process model, you must determine your document storage
and tracking requirements and the appropriate settings you need to set for archiving and purging stored
process data. For information, see Maximizing Visibility Into Business Processes on page 28.

Maximizing Visibility Into Business Processes

The application provides a variety of monitoring and tracking tools that aid visibility into both your active
and completed processes.

As you plan your process models, considering the degree of access you need to detailed processing
information is important, because you can configure related settings while you create your process models.
Configure your processes and related resources to enable the visibility you need into processing details,
along with the type of historical processing data you want to be able to access when you use monitoring and
tracking tools.

Monitoring and Tracking Considerations

You can configure your business processes to enhance your business process monitoring and document
tracking options in different ways. The tracking options you configure determine the level and quantity of
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tracking detail specific to documents, as opposed to business processes themselves, that is available in the
application. Tracking selections may affect system performance. Consider the following:

4 Using the document tracking flag at check-in — When you check in a business process, you have the
option to enable or disable document tracking.

When you have enabled document tracking for a business process, the system carries tracking
information with the document throughout the process, and persists the tracking information about the
document regardless of the persistence level you configured globally for the application.

Document tracking in a business process allows you to use monitoring features to track processing
history, view transaction details, obtain processing state information, and so forth, for documents.

By default, the document tracking option is disabled for all business processes in the application.
Therefore, even if the global system tracking option is configured to enable tracking, your business
processes will not will not provide the specialized document tracking unless you enable document
tracking at check-in.

Using document tracking may affect system performance. Determine your document tracking and
performance needs before creating your business process models.

4 Setting Tracking Level for EDI services — For EDI-related business processes, you can boost
performance without having to modify multiple business process models by changing the tracking
level setting in envelope properties to either None or Basic, depending on the level of functionality you
need. The only reason to adjust EDI tracking is for performance reasons. There is a trade-off in that
you need must ensure that you still track all the data you need if you lower this level

If, instead, you use the tracking level service parameter to set this value, the tracking level service
parameter setting overrides the enveloping properties setting.

4 Using the Correlation service or name-value pairs for correlation searches — You can configure
services to collect information for a specific name and value pair from either documents that pass
through the business process, or from the business process itself. For information, see Assigning
Name-Value Pairs in a Business Process Model on page 46.

4+ Invoking subprocesses to run inline — For tracking purposes, a subprocess initiates as a new business
process with its own instance 1D. However, you can opt to run a subprocess in inline mode by selecting
inline as the invoke mode in the parameters for the Invoke Business Process service that calls the
subprocess. This way, the subprocess steps are reported in tracking as part of the parent process.
Recommended practice is to always use inline invoke unless you have a business need to run a
separate process.

Persistence Levels and Archive and Purge Settings

When your business processes run, the application saves data according to the level of persistence you have
set (see Persistence Level on page 57). You can access more or less saved information about the processes
you run, depending on the degree of persistence you set (remember that enabling document tracking
overrides persistence settings related to documents). The length of time that the persisted data is available
to you depends on the lifespan of the defined process.

In the same manner that you schedule initiation of business processes, you can schedule the intervals at
which you want the application to archive and purge the contents of the database. Configuring archiving and
purging enables you to define the length of time, in days and hours, to retain the data persisted in the
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application. Performance considerations may influence your options, as a great deal of data in the database
can slow operations. For more information, see Life Span on page 62.

Document Storage Considerations

Document storage settings determine the storage location you want for documents that process when the
business process runs. The levels are:

4 Database — Store documents in the database. Use this option for small documents or when clustering
without a clustered file system.

4+ File System — Store documents in the file system. Use this option for large volume processing, such as
documents that are over 10 MB in size, or when working with a large number of documents within a
single business process (including any sub-processes it invokes).

Note: If you are using archiving, and you using the file system document storage method, you must handle
purging the documents from your file system manually.

4+ System Default — Use the default option configured in the jdbc.properties file. As shipped, the database
is the system default. You may have modified this to use the file system.

4+ Inherited — Store documents according to the document storage setting applied to the service that is
invoking this business process. Use this option when the process is invoked by a bootstrap adapter and
you want the document storage method to carry from the invoking adapter to the process.

4+ This option enables you to configure the process model to use the same document storage method as
the bootstrap adapter that will invoke the process.

For additional information about the processing options you can select when you check in a business
process, see Business Process Model Processing Options on page 55.

When you have completed Stage 7, you may benefit by filling out the Planning Worksheet for your business
process model. The worksheet is a form you can use to note conceptual and technical details about a process
model and refer to it during the actual modeling of your process.

Using Predefined Business Process Models

The application provides a variety of predefined business process models for your convenience. In addition,
any business process model you have previously created and checked in essentially becomes a predefined
business process. You can use a predefined process in the following ways:

1. Use it as asubflow in a new process model.
To do this, you must:

+ Check out the predefined process and save it with a new name. This should be the name of the
process model you are creating that will include the predefined process.

+ Inthe GPM, open the file you checked out and saved.
¢ Create a subflow in the process model and add the predefined process to it.

+ Model the rest of your business process related to the subflow.
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¢ Test the model and check it in to the application.

Remember that after you use a process as a subflow in a new process, any changes you may make later
to the originally copied process will not be reflected within the subflow. For instructions for adding a
subflow within a process model, see Adding Subflows in the GPM on page 43.

2. Configure a step in your process model to execute a predefined process as a subprocess.
To do this, use the Invoke Subprocess service.

The benefit of using this technique is that if you later make changes to the predefined process, the
process model that calls the predefined process as a subprocess uses the most current version.

For tracking purposes, a subprocess initiates as a new business process with its own instance ID.
However, you can opt to run a subprocess in inline mode. Using this option, the subprocess steps are
reported in tracking as part of the parent process. Running the process inline enables you to maintain
reusability and inherited updating without the possibility of negatively affecting system performance
by starting a new business process. You set the inline options in the parameters for the Invoke Business
Process service.

3. Use it as a foundation for a new process.
To do this, you must:

+ Check out the predefined process and save it with a new name. This should be the name of the
process model you are creating.

¢ In the GPM, open the file you checked out and saved.
¢ Modify the configuration of the business process model as needed.

+ Test the model and check it in to the application.

Locating and Identifying Predefined Business Process Models

To review predefined business process models and determine whether they will fulfill your needs, you must
open the files for the models and review their components. To do this, check out the business process and
open it in the GPM, or view the source BPML in the interface. You can open a read-only copy.

To view the source BPML in the interface:
1. From the Business Process menu, select Manager.
2. Under List select ALL and click Go!

3. Click the name of the business process for which you want to view the source , and review the source
BPML in the window that displays.

For descriptions of several commonly used predefined business processes, see Commonly Used Predefined
Process Models on page 81.

Note: The reference information for each service and adapter identifies any predefined business processes
associated with it. You can use this information as a starting point for finding a useful predefined
process.
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Decision Points and Rules in Business Process Models

To configure decision points in your business process models, you must:

4+ Define a rule upon which conditions will be based.
4 Add the decision point in your process model.
4 Assign the rule and related conditions to the decision point.

For example, for a decision point at which the flow of a business process model splits into two paths
determined by the total amount of a purchase order, you define a rule indicating the total amount of the
purchase order, such as: PO is greater than $10,000.

Then, you must assign the rule to the decision point within your process model, and indicate the conditions
by which the data progresses through each path from the decision point. For our example, if the total PO
amount is greater than $10,000 (true to the rule), take path A; and if the total PO amount is not greater than
$10,000 (not true to the rule), take path B. The following diagram illustrates the concept:

Business process

‘ Decision point Paths determined by conditions

Therule Activity

is true

Choice

Initial (Rl = PO e ~ Process
prct)cess is > $10,000) . Continues
steps

Theruleis

not true Activity

Rules and Conditions for XML Documents

When running a business process that processes XML documents, you must use XPath to describe rules and
conditions for processing the XML document. Specifically, you must create XPath expressions that:

4+ ldentify particular elements (or nodes) and their positions in both the input and output documents.

4+ ldentify particular elements in the input document for copying into an output document or for further
processing.

4+ Define any constraints of name-value pairs for elements.
4 Calculate values that depend on other values.
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The following table shows sample names and rules using simple syntax:

Name Rule
rulel X>10
rule2 X<=10
rule3 X<10

For information about assigning rules that require complex syntax, see Defining and Assigning Rules and
Conditions on page 44.

BPML Activities in Business Process Models

Some BPML activities must be used in pairs, to bracket other activities. That is, for a given processing step
in a business process model, you must use one of these bracketing activities at the beginning and one at the
end. These are considered to be parent activities. For example, before each service in a business process
model, you must include the Sequence Start BPML activity, and after the service you must include the
Sequence End activity. Other BPML activities enable more complex activities.

4 Parent Activities Used in Pairs on page 33
4+ More Complex BPML Activities on page 34

This topic explains requirements related to your use of BPML activities in business process models. Your
processes may not run correctly if you do not use the BPML activities according to the requirements
outlined here.

Parent Activities Used in Pairs

The following table describes the BPML icons in the GPM that represent activities used to bracket other
activities:

Icon Description

The Start activity indicates the beginning of a business process. Every business process
model must begin with Start.

The End activity indicates the end of a business process. Every business process model
must finish with End.
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Icon Description

The All Start activity is a parent activity in a business process. All Start indicates that a
business process is simultaneously executing all of the child activities contained within the
parent activity.

The All activity runs two or more complex child activities within a business process
simultaneously. Because there are performance implications to using the All activity, use it
only if you expect branches of your business process model to take significant amounts of
time (in seconds or minutes) to complete (very few services take this long).

Do not use the All activity to run two or more instances of the same subprocess
simultaneously. The system will handle the proper load balancing.

The All End activity indicates that all child activities within the parent activity are completed.
Use All End to finish All Start.

The Choice Start activity is a parent activity in a business process. Choice Start indicates a
decision and runs one child activity as a result of that decision. You must assign a name to
Choice Start using the Property editor and assign rules using the Rule Manager.

The Choice End activity indicates that the child activity that ran as a result of the parent
activity is completed. Use Choice End to finish Choice Start.

The Sequence Start activity is a parent activity in a business process. Sequence Start runs a
series of child activities in the order in which they are listed within the parent activity. When
using Sequence Start, you must assign a name using the Property editor.

The Sequence End activity indicates that the last child activity in a series of child activities in
the parent activity is finished. Use Sequence End to finish Sequence Start.

More Complex BPML Activities

The following BPML activities are not used in pairs to bracket business process model components. Rather,
they enable more complex operations within a business process. The following table describes the icons and
activities:

Icon Description

The Assign activity sets a value in the business process data that is equal to a fixed value. Inside an
input or output element, the activity identifies a message it should receive from a participant or
identifies the contents of a message it should send to a participant.

Configuration parameters enable you to indicate a fixed value or input/output message.
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Icon Description

The Consume activity reads a specific input message and stores that message in the business
process data.

Configuration parameters enable you to indicate a name for an instance of the Consume activity
and the name of the message this activity should read.

The Join activity merges the results of a completed nested business process into the business
process data.

Configuration parameters enable you to indicate a name for the business process for which the Join
activity is waiting.

The OnFault Group activity is a subflow used to associate a fault handling activity with a complex
activity. Use it to recover from faults and allow the process to continue.

The Produce activity generates a message from the business process data and deliversitto a
designated participant or activity.

Configuration parameters enable you to indicate the message and name of the receiving participant
or activity.

The Repeat activity runs an activity or subflow one or more additional times.

Configuration parameters enable you to indicate a name for an instance of the Repeat activity and
the name of the activity the Repeat activity should run again.

The Spawn activity runs a subprocess.

Configuration parameters enable you to specify a name for a copy of the Spawn activity within a
process model, as well as the name of the subprocess to invoke.

Sterling Commerce, Inc. 35



Creating Business Process Models

About Creating Business Process Models

The application enables you to use different applications to create your business process models, as
indicated in the following table:

Application

Description

Graphical Process
Modeler (GPM)

Web-deployed application included with the application. The GPM interacts directly with
the application although it is an independent application. The GPM offers ease-of-use,
including:

¢ Process model validation and check-in integrated with the application

¢ Visually represented and manipulatable modeling components including the
application services and adapters

¢ Configuration tools that do not require advanced BPML knowledge

Unless you have advanced knowledge of BPML, XPath, and ebXML syntax, use the
GPM to create your business process models.
For instructions for creating a business process model using the GPM, see Creating or

Modifying a Business Process Model in the GPM . For information on BPML activities
used in the GPM, see BPML Activities in Business Process Models.

Text editor application

If you are experienced with using a text editor to create business process models in
BPML code, you can use a text editor application. The application interface provides a
built-in text editor in which you can enter the BPML code and validate and check in your
process models. If you have written the BPML code in a text application external to the
application, you can copy the text from the external application and paste it into the
application text editor.

For instructions to create a process model using a text editor, see Creating and
Modifying Business Process Models In the Text Editor .

Unless you have advanced knowledge of BPML, XPath, and ebXML syntax, use the
GPM to create your business process models.

Non-application
graphical editor
application

Process models created in other graphical editors may be imported into the application,
provided they are exported in a standard XML format. The imported business process
model, and some services, may require modification for correct execution in the
application.
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Process Summary of Creating a Business Process Model in
the GPM

The following table lists the stages in the process of creating a business process model using the GPM. The
table provides links to additional information.

This process assumes that you have completed the planning steps described in Business Process Model
Planning Stages on page 19 and reviewed Business Process Modeling Best Practices.

Stage Description For details, see:

1. Create the business process, including the appropriate service * Creating or Modifying a
configurations. Business Process Model in the
* If an existing service configuration meets your business needs for GPM on page 38.

the process, use that service configuration.

¢ If no existing service configuration meets your business needs,
create a new service configuration or determine whether you can
edit an existing configuration to make it more generic for reuse.

Note: To avoid negatively affecting your other business
processes, do not edit an existing service configuration
until you understand its impact on your other business

processes.
2. Configure the process to call subprocesses, if needed. # Using Predefined Business
Process Models on page 30
¢ Identifying Subprocesses on
page 21
3. Add subflows, if needed. ¢ Adding Subflows in the GPM on
page 43
4, Configure any required and optional parameters for services and * Configuring Parameters in GPM
adapters in your process, such as metadata and message data. Element Editors on page 41
5. Assign rules and conditions to decision points, if needed. * Defining and Assigning Rules
and Conditions on page 44
6. Configure services to enhance monitoring and tracking capabilities, if o Assigning Name-Value Pairs in
needed. a Business Process Model on

page 46
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Stage Description For details, see:

7. Validate and save the business process model. In the application interface, this step

For information, see Business Process Model Validation on page 52. 1S included in two larger processes:

¢ Creating a process model in the
text editor — for information, see
Creating and Modifying
Business Process Models In the
Text Editor on page 48.

¢ Checking in a business process
model created in the GPM. For
information, see Checking In a
Single Business Process Model
in the GPM on page 63.

In the GPM, you can validate a
process model during the creation
process or at any later time.

Creating or Modifying a Business Process Model in the GPM

You can create an original business process model from scratch, or by modifying an existing process model
and saving it with a unique name. If you are using an existing process model as the foundation for your new
process, see the following topics for more information: Using Predefined Business Process Models on page
30 and Copying a Business Process Model for Use In the GPM on page 47.

Before using the GPM, review the GPM documentation.

Preliminary Configuration Tasks

You must perform the following configuration tasks before creating a process model:

4+ Create any necessary service configurations in the application. For information about service
configurations and business processes, see Service Configurations in Business Process Models on page
14,

4+ \alidate and check in any business process model you intend to invoke (use as a subprocess) from this
process. Subprocesses must be checked in to the application in order to test this process.

Procedure

To create a business process model using the GPM:
1. Open the GPM.

Sterling Commerce, Inc. 38



10.

11.

12.

13.

Creating or Modifying a Business Process Model in the GPM

In the GPM, from the File menu, select New to open a new document, or open the .bp file you want to
use as a foundation for a new process model (checked out business process models are saved as .bp
files).

Note: If you open a business process model that was created or edited in the text editor, the GPM
displays the components in “autolayout” mode—the icons are aligned in a linear arrangement.

Open the stencils containing the service icons you need to create the business process model. For each
stencil you need, from the View menu, select Stencil > <stencil name>.

Click the title bar for the BPML stencil to expand the stencil (the BPML stencil is open by default).

If you are creating this process model from scratch, add the Start icon to the business process
workspace by dragging and dropping that Start icon onto the workspace.

To add an icon to a business process model, click to select the appropriate icon from within a stencil,
and then, holding down the mouse button, drag the icon onto the workspace and release the mouse
button.

Add other icons to the business process model as needed:

+ From the BPML stencil, add icons representing BPML activities and instructions required in your
business process.

+ From the stencils, add icons representing services, BPML activities and instructions, and
integration points in your business process.

This step might include adding one or more subflows, as well as services to invoke other process
models (subprocesses).

For more information, see the following topics:
- If you want to use a service that is not installed, contact your system administrator.
- Adding Subflows in the GPM on page 43.

- For how to invoke another process model from within this one, see Using Predefined Business
Process Models on page 30.

If you are using a predefined business process model as the basis for creating this process model,
remove any icons that you do not need to keep for the new model.

If you are creating this process model from scratch, add the End activity to the business process model.

Arrange the icons in the order that meets the requirements of your business process. Do not use the
Autolayout tool unless you have arranged and linked your icons first (complete step 10), because it
will line up the icons in a vertical row that takes time to reorganize appropriately.

To link the icons, click the arrow on the right side of the first icon and drag it to the arrow on the left
side of the next icon. Repeat as necessary.

Customize descriptive annotations to your model, if desired. For instructions, see Modifying
Annotations on page 46.

Assign any name-value pairs that represent data to locate in process data, as needed. For instructions,
see Assigning Name-Value Pairs in a Business Process Model on page 46.

Assign rules and conditions to decision points, if needed. For instructions, see Defining and Assigning
Rules and Conditions on page 44.

Sterling Commerce, Inc. 39
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14. Configure parameters as needed for services, adapters and BPML activities. For instructions, see
Configuring Parameters in GPM Element Editors on page 41.

15. From the File menu, select Save to save the business process model document (.bp file) to your client
computer. If you have configured the GPM to validate automatically when you save a file, the system
validates your process model now.

If this is a new process created from scratch, give the business process model a unique and meaningful
name so that you can identify it easily.

16. In the Save dialog box, select a directory on your client computer and click Save.

After creating a business process model, at any time, you can open the file for your business process
model and configure parameters, add subflows as necessary, assign rules and conditions, validate it, or
otherwise modify it.

In order to test or run the process in the application, you must:

+ Validate the process model’s format. For information, see Business Process Model Validation on
page 52.

+ Check the model in to the application (your test or production environment, accordingly). For
instructions, see Implementing a Business Process Model on page 51.

¢ Create and check in any other resources (such as Web templates, service configurations, maps, and
so forth) that will be used by this model.

You can now check in and test your business process model. If needed, create a schedule for running this
business process model.

When to Configure Services for Business Process Models

The services you include in your business process model may require configuration in order for your process
to run correctly. You configure some parameters in the application interface (this is called creating a service
configuration), some in either the interface or the GPM, and some exclusively in the GPM. A few require
manual editing in the BPML code. The reference documentation for each service describes the parameters
for the service and indicates where to perform the parameter configuration.

Generally, you can configure service parameters either during initial service configuration in the application
interface, or during business process creation using the GPM. You can modify service configuration
parameters at any time.

About Refreshing the Service Configurations in the GPM

If you are working in the GPM and you use the application interface to change the configuration for a
service, you must select View > Refresh Services to update the GPM with your modified service
configuration.
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Configuring Parameters in GPM Element Editors

Configure service parameters in the GPM when you need to customize the service for the business process
you are creating or modifying. To configure parameters:

1. Inthe workspace, double click the icon representing the service, adapter, or activity you want to
configure.

The GPM displays the appropriate element editor for the selected element in the Element Editor pane
beneath the workspace. For example, when you select the Assign icon, the Property editor opens,
providing parameters to configure. For most services, the Service editor displays.

2. Configure the parameters by entering the appropriate values in the related fields as needed.

For Service Editor only: The following table describes parameters in the Service editor. Some
services and adapters have additional parameters that display in addition to the parameters described
here, which are documented with the service information.

Field Description

Name Name of the service you are using in your business process model.

You can customize the name, but, to facilitate your future reference, the best practice is to leave
the name as-is or to include the service name in the new name you create. This is especially
helpful should you need to identify business processes that may contain retired services at a later
date.

Config Name of the service configuration for this service that you want to use in this business process
model. The field displays previously created service configurations for the selected service.

After you select a service configuration, additional configuration parameters display.

Output Msg Choose one of the following types of information:
¢ Message Only — Send only service configuration information to a service.

¢ Obtain Message first, then Process Data — Send service configuration information, name-value
pair in the Service editor, and business process data. If duplicate information exists between
the service configuration and business process data, the business process data overrides the
service configuration information.

¢ Obtain Process Data first, then Message — Send service configuration information, name-value
pair in the Service editor, and business process data. If duplicate information exists between
the service configuration and business process data, the service configuration information
overrides the business process data.

Note: When sending name-value pairs, you must indicate in the Service editor the name and
value that describes the path for sending the name-value pairs.

For more information about name-value pairs, see Assighing Name-Value Pairs in a Business
Process Model on page 46. For information on Output Msg, see What is Process Data?.

Input Msg When a service sets variables in business process data (select one):
¢ Allow message write — Do not save the variables.

¢ Allow Process Data write — Save the variables.

For more information about Input Msg, see What is Process Data?.
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Do you need to configure any XPath expressions for the service?

+ |f Yes, see Adding XPath Expressions to Service Configurations in the GPM on page 42.

+ If No, proceed to the next step.

Do any?

Are you trying to configure a parameter that is read-only?

+ If Yes, complete the procedure in Modifying Read-Only Parameters in the GPM on page 42.
+ If No, proceed to the next step.

When you are finished, you can close the Editor tab in the Element Editors pane by right-clicking the
Editor tab and selecting Close Editor Tab. However, you do not need to close the pane. Any time you
double-click a step in the process model, the display automatically changes to the appropriate editor
for the selected icon. Likewise, if you validate the process model, the pane changes to display the
system output messages.

Modifying Read-Only Parameters in the GPM

At times, you may need to modify service parameters but find that they display as read-only in the GPM
Service editor. Some service parameters that are configurable in both the application interface and the GPM
display as read-only in the Service editor if you configured them in the interface prior to working with them
in the GPM.

The GPM enables you to override these preconfigured settings so that you can modify the parameters. To
enable the parameters to be changed in the GPM:

1.
2.
3.

From the Options menu, select Preferences.
Select the Service Editor tab.
Select Override Default Service Configuration Values and click OK.

If the Service editor is already open when you complete these steps, you must exit the Service editor
(right-click the Editor tab and select Close Editor Tab) and then re-display the Service editor for the
change to take effect (double-click the service icon in the workspace).

Adding XPath Expressions to Service Configurations in the GPM

To add an XPath expression to a service configuration,

1.

2
3.
4.
5

Select the service in the Workspace and in the Service editor, click Advanced.

Click Add to display the Name and Value columns.

In the Name field, type a unique name for the rule you are creating.

Click in the field under the Value column and select the ... button.

In the Value of Null dialog box, click the A + B button to display the XPath Expression Builder.

After closing the Service editor, point to the value column in the Advanced editor so that the
expression button disappears. This action sets values.

Create your expression, following the instructions for using the XPath Expression Builder.
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7. Click OK. See also Assigning Name-Value Pairs in a Business Process Model on page 46.

Adding Subflows in the GPM

When you create a subflow, you create a layer in the business process model. You can expand the view to
work with the components of the subflow by using the Layers tab in the Navigation pane.

While a subflow layer provides more design space, it does not create a separately-saved business process
model. A subflow is an integral part of the process for tracking purposes.

For information about planning subflows for your business process models, see Organizing Your Business
Process Models on page 26.

To add a subflow:

1.

From the Tools menu, select Add Sub Flow. The GPM adds the subflow icon to the workspace and
expands the structure in the Navigation pane to show the subflow.

In the workspace, drag and drop the subflow icon to the appropriate location within the business
process model.

You may need to remove the link that connects two previously arranged icons in order to insert the
subflow icon. To remove the link, click the link and press Delete.

Link the icons accordingly.

To rename the subflow, select the subflow icon, right-click, and select Properties to display the
Property editor. Type the name for the subflow in the Value field. When you click out of the Property
editor, the subflow icon displays the new name in the workspace. Now you are ready to configure the
subflow components.

In the Layers tab of the Navigation pane, click the subflow to display the workspace for the subflow.
The GPM includes unlinked Start and End icons for your convenience.

Create a business process model for the subflow:

Add the icons that meet the requirements of your business process.
Arrange the icons.

Link each icon, including the Start and End icons.

Align the business process model.

® o o T @

Configure parameters for the icons in the subflow using the element editors as needed.

Do you want to continue working on the parent business process model (the one that the subflow is
part of)?

+ Ifyes, in the Navigation pane, click the parent business process model icon to display to the parent
process in the workspace.

+ |f no, save the business process model or validate and save the business process model.
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Defining and Assigning Rules and Conditions

To include rules and conditions at decision points in your business process models, you must complete two
procedures:

1.

Define rules. These may be simple or complex. For instructions, see:
¢ Defining Simple Syntax Rules on page 44
¢ Defining Complex Syntax Rules Using XPath on page 44

Assign the rules and related conditions in a business process model. After defining your rules, or if
your rules are already created, see Assigning Rules and Conditions in Business Process Models on
page 45.

These procedures assume you have planned your business process model and created its core structure in
the workspace in the GPM. For a conceptual overview, see Decision Points and Rules in Business Process
Models on page 32.

Defining Simple Syntax Rules

1.
2.
3.

5.

From the Tools menu, select Rule Manager.
Click Add.
In the Name field, type a name that describes the rule.

For example, if you are creating choice within your process model that determines what step to take if
the total amount in a purchase order is greater than or less than $10,000, you might define a rule named
TotalPO.

In the Expression field, type the syntax, and then click OK.
Following the example in step 3, the expression might be document/total> 10000.
Repeat these tasks until you finish defining simple syntax rules.

You can now assign rules you have created to steps in a business process model. See Assigning Rules and
Conditions in Business Process Models on page 45.

Defining Complex Syntax Rules Using XPath

1.
2.
3.

From the Tools menu, select Rule Manager.

Click Add.

In the Name field, type a name that describes the rule.

For example

To display the XPath Expression Builder, click the (A + B) button to the right of the Expression field.

Display the expression type you want to perform, double-click the function to add it to the Expression
field, and then type values to complete the expression type as needed.
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7.
8.

Defining and Assigning Rules and Conditions

Display the token set attribute to complete the function of the expression type and double-click the
attribute to add it to the Expression field.

Repeat steps 1-6 until you finish defining this XPath expression and click OK.
Repeat steps 3-7 until you finish creating rules defined by complex XPath.

You can now assign rules you have created to steps in a business process model. See Assigning Rules and
Conditions in Business Process Models on page 45.

Assigning Rules and Conditions in Business Process Models

In the process of creating the core structure of your business process model in the workspace, you may have
already completed steps 1 and 2.

To assign rules:

1.

Choice Start

To a business process model open in the workspace, add the decision point to which you will assign
rules, along with related icons for each possible processing sequence (you may need to remove the link
that connects two icons in order to insert the new icons):

a. At the appropriate point in the process model, add the following icons:
¢ Choice Start and Choice End

+ Two copies of Sequence Start and Sequence End

+ Icons for the activities required in each sequence. For example, two copies of the Assign icon.
b. Arrange and link the icons. For example:

[E]——{=——>[]

Sequence Start Assign Sequence Start

Choice End

[E]——=—[z]

Seguence Start Assigh Sequence End

Configure the parameters for the service in each sequence as necessary (for example, the Assign
activity icons). For instructions, see Configuring Parameters in GPM Element Editors on page 41.

Rename the following icons as indicated:
+ Rename Choice Start to describe the decision activity. For example, CheckTotalPO.

¢ Rename the Sequence Start icons to describe the condition related to each flow path. For
example, one might be Total10000 and the other might be TotalNot10000.

Double-click the edge (link line) between Choice Start and one of the Sequence icons to display the
Edge editor.

In the Edge editor, click Add to display the name and value columns.
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6. Inthe Name column, click in the field to display a list of previously-created rules, and select the
appropriate rule. This will be the rule name displayed with the selected edge in the business process
model.

7. Inthe Value column, select True or Not true for the selected rule.

When you click in the workspace, the rule name displays on the edge in the process model.
8. Do you need to assign more rules to this edge?

* If Yes, repeat steps 5 - 7 until you finish assigning rules to this edge.

+ If No, repeat steps 4 - 7 for other edges to which you must assign rules.

Modifying Annotations

You can customize annotative descriptions of components in your process model. Though you cannot delete
the default annotation for an icon, you can modify it to provide descriptive information that is useful to you.

To customize an annotation:

1. Inthe workspace, select the icon for which you want to customize the annotation.
2. From the Edit menu, select Annotation.

3. Inthe Annotation dialog box, type the annotation, and click OK.

Deleting an Annotation

You can delete a custom annotation by clearing it, but the GPM automatically replaces it with the default
system annotation for the icon. To delete an annotation:

1. Inthe workspace, select the icon for which you want to delete a custom annotation.
2. Right-click to display the menu and select Annotation.
3. Click Clear, and then click OK.

Assigning Name-Value Pairs in a Business Process Model

Assigning name-value pairs to business processes and documents enables you to easily search for and
monitor the business process and related documents. Name-value pairs, which are called correlations in the
application, enable a business process to identify corresponding elements (or nodes) and their positions in
both the input and output documents.

You can use any of the following methods to assign name-value pairs:

4+ Applying the provided name-value pairs provided in the GPM to a service
4+ Creating your own unique name-value pairs for a service
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4+ Implementing the Correlation service to enable the application to generate correlations, according to a
business process, or according to documents exchanged as a result of a business process that ran.

Assigning Provided Name-Value Pairs in the GPM

To assign name-value pairs to a service:
1. To display the Service editor, select the icon representing a service or adapter and click Properties.

2. Under the Value column, select the value that describes the name-value pair corresponding with
elements in both the input and output documents.

Creating Unigue Name-Value Pairs

To create unique name-value pairs for a service:

1. To display the Service editor, select the icon representing the service or adapter and click Properties.
2. Click Advanced to display the Advanced Editor.

3. Click Add to display the Name and Value columns.

4. Under the Name column, type a unique name to describe the value in the field.

5. Under the Value column, type a character or XPath expression that describes the value in the field.

Note: To use the XPath Expression Builder to help you create an XPath expression, click the ellipses
button to display the Value of Null dialog box, and then click the button to the right of the Value field
to display the XPath Expression Builder. See Adding XPath Expressions to Service Configurations in
the GPM on page 42.

6. Under the Use XPath? column, enable the field to indicate that you are using an XPath expression for
the value, and then click Add.

7. Repeat steps 1 - 6 until you finish creating name-value pairs for this service or adapter.

Using the Correlation Service

When you use the Correlation service in a business process, the application generates correlations for
business processes that completed document exchange while running. After running the business process,
you can then use the generated correlations when you search for a business process or document results in
the application.

Before using the Correlation service, you must determine whether you want the application to generate
correlations according to the results of business processes or document exchange.

Copying a Business Process Model for Use In the GPM

At times, you may want to copy a business process model and use it as the foundation for a new one. To
copy a business process model:
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1. Check out the business process you want to copy and save it with the name of the new process model
you are creating.

In the GPM, open the business process model you checked out.
Modify the business process model as needed.
Validate and check in the new process model.

o &~ D

If you locked the original business process model at checkout, and you need it to be available in the
application, check it back in.

Creating and Modifying Business Process Models In the Text
Editor

Creating a business process model using a text editor rather than the GPM requires advanced knowledge of
BPML, and XPath. Unless you are an advanced user, use the GPM to create your process models.

The process for creating a business process using a text editor in the application includes validation and
check-in of the process model. The following procedure details the steps:

1. From the Business Process menu, select Manager.
2. Do one of the following:
¢ To create a new process model, next to Create Process Description, click Go!

¢ To modify an existing process model, use the Search or List feature to locate the model to modify,
select Source Manager for the process, and click Edit. Go to step 5.

3. Type the name to identify the business process you are creating. The name must not contain spaces.
See Process Name on page 55.

4. Under Select an input mode for defining the new process, select Business Process Text Editor and
click Next.

5. Type a description that helps identify the business process you are creating or modifying. See
Description on page 55.

6. Inthe Business Process field, either type, or copy and paste, BPML code.

7. Click Validate to validate the BPML syntax (you cannot enable a business process until it is
validated).

A system message indicates whether the process is valid or invalid.
8. Is the process valid?

+ |f No, correct invalid BPML code and repeat step 7 as necessary. You can view error information
by clicking the link in the error message.

¢ |f Yes, click Next.

9. Select Document Tracking if you want to track the progress of the document when the business
process runs. See Document Tracking on page 55.
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10.

11.

12.

13.
14.

15.

16.

17.

18.
19.

20.

Creating a Subprocess

Select Set onfault processing if you want the business process to run its onFault protection if it
encounters an error when it is running. See Set onfault processing on page 56.

In the Set Queue field, indicate the level of queue, previously defined to allocate resources, at which to
place this business process for processing. See Set Queue on page 56.

Indicate the level of persistence to retain data that makes up the business process. See Persistence
Level on page 57.

Indicate the level of event reporting for this business process. See Event Reporting Level on page 58.

Indicate the level of recovery for this business process if the business process should halt during
execution. See Recovery Level on page 58.

Indicate the type of document storage for documents that process when the business process runs. See
Document Storage on page 58.

Click Next and select deadline settings for the business process to run. See Deadline Settings of the
application on page 61.

Click Next and indicate the life span (archiving information) for the level of persistence data you are
retaining. See Life Span on page 62.

Click Next.
To enable the business process, ensure that Enable Business Process is selected.

If you do not enable the business process, you cannot run it in the application without first enabling it
later. For instructions to enable it independently of the check-in procedure, see Enable a Disabled
Business Process on page 79.

If you want to create a permission associated with the business process model, select Create
Permission, and then click Finish.

You can now test the business process model. If needed, create a schedule for running this business process
model.

Note: Ifyoueditafile in BPML and then open the file in the GPM, the model displays in Autolayout mode;

it does not keep its original GPM layout, if applicable, after its source file has been manually edited.

Creating a Subprocess

The following steps describe the process of creating a subprocess:

1.

Follow the instructions for creating a business process model, remembering that a subprocess should
comprise a simple, single unit of work.

Validate the subprocess.
Check the process model in to the application.

Test the subprocess, monitoring the activity. If needed, modify the process model and repeat steps 1-4
as needed.
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Create a business process model that calls the subprocess (this is the parent business process model).
The Invoke Business Process service enables you to call the subprocess from the parent process and
specify the processing mode (asynchronous, synchronous, or inline).

Validate and check in the parent business process model.

Test the parent business process model, monitoring the activity. If needed, modify the process model
and repeat this step as needed.

Run the parent business process as needed.

Using the OnFault Group in the GPM

The GPM contains an OnFault Group in the BPML stencil. The OnFault Group may contain one onFault
element or many onFault elements. In the Property Editor there is an Add button that will add additional
elements as needed. Configure an onFault element by:

1.
2.

3.
4.
5
6

From the workspace, select the OnFault Group icon where you want to view an element editor.

To access the element editor where the onFault element can be modified or additional onFault
elements can be added to the OnFault Group, select Properties from the Edit menu.

Click in the Name or Error Value fields

Click the view button.

The Workspace will contain an OnFault Start and an OnFault End.

Add the process you want to run when the fault specified in the Error Value field occurs.

Note: The Error Value field must match an error in GIS for that element to execute. If you leave the Error

Value field blank, all errors will execute that branch unless the specific error has its own element.
The first onFault element could have a specific value and the second element could be blank. That
way the specific error would execute the first element and all other errors would execute the second
branch.
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About Implementing Business Process Models

After creating or modifying a business process model, you must perform implementation steps before
running it in the application. The implementation process involves:

1. \Validating the process model. For information, see Business Process Model Validation.

2. Creating a definition of the process model in the application. For information, see Creating a Business
Process Definition.

3. Checking the process model in to the application. For information, see About Checking in Business
Process Models.

4. Testing that the process works as planned. For information, see Testing the Business Process Model.

Use a test environment for checking in and testing your processes before you run them in your
production environment.

Because implementing a process model often involves working with revised versions of pre-existing
models, before you begin, review the information about version management. See Managing Business
Process Model Versions.

Managing Business Process Model Versions

Version management is an important concern related to implementing your business process models. As you
make multiple changes to existing process models and create variations of a process model, you need to be
certain that the process model that runs is the appropriate version.

The first time you check in a business process, the data you enter creates a business process definition—a
uniquely named copy of the process model to be stored in the application. The business process model
stored in the application is independent of any .bp file of the process that you may have saved in a local
directory.

At any time, you can open an existing process model, modify and save it, and then either check in the new
version to the application, or save the modified copy of the process in the application as a new process
altogether. All previously checked-in versions of business process models continue to be stored in the
application. This enables you to revert to using an older version should the need arise.
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For more information, see Modifying and Managing Business Process Models.

Business Process Model Validation

The application BPML validation feature checks for proper BPML syntax in your process models and looks
for faulty design, to help you avoid common pitfalls that lead to processing problems. Y our business process
models must pass validation before you can enable them for use in the application.

The following table describes the checks performed when you validate a business process model in the
application:

Validation Check Description
BPML syntax Verifies that the BPML comprising a business process model is valid XML.
ForEach/Invoke Loop Verifies that a faulty document looping structure is not part of the business process

model. The problem loop contains:
¢ A For Each Document service

¢ An Invoke Business Process service
This loop structure will fail validation unless the loop also contains:

¢ An Assign activity to a message_to_child element that makes a specific reference to
which document to use for the next cycle

¢ A Release service targeting the value "message_to_child" (this keeps unneeded
copies of documents from being created)

OR

¢ One or more assign elements to message_to_child in the Message To Service of the

Invoke Business Process service (in this case, the Release service is not needed)
An improper document loop structure unduly taxes the database and can lead to
production down scenarios, particularly if you are processing large files.

If the validation check finds this structure, it returns one of the following errors, depending
on the structure:

¢ Node Validation Error:
Activity Name: Invoke Business Process Service
Validation Message: Document loop contains an InvokeBusinessProcess service
without an assign to message_to_child.

¢ Node Validation Error:
Activity Name: foreachSplitDoc
Validation Message: message_to_child not guaranteed to be released in document
loop.

You can validate your business process models in both the GPM and the application interface.
4+ Validation in the GPM

In the GPM, you can save a business process model at any time and then validate it later, or you can
configure the GPM to validate every time you save the file. By default, the GPM prompts you to
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validate a model when you save it (to disable or enable this behavior, select Preferences from the
Options menu).

Because you may check in unvalidated process models or processes containing validation errors using
the GPM, be sure to validate before check-in. Processes that are checked in but not valid are not
executable. For more information, see Checking In a Single Business Process Model in the GPM.

4+ Validation in the application Interface

In the application interface, validation is part of the procedure for either checking in a process model
created in the GPM or creating a business process model in the text editor.

For more information about the types of check-in procedures, see About Checking in Business Process
Models.

Validating Pre-existing Business Process Models

Any time you have upgraded the application software and you want to re-validate previously implemented
business process models using the upgraded application, simply check the process models out and check
them back in again.

Creating a Business Process Definition

A business process definition is the name and some additional processing instructions that you assign to a
business process model when you check it in to the application for the first time.

You create the business process definition during the check-in process:
4 During the Add (check in) process in the GPM
4+ When you create a new process definition in the application interface

Create a definition only the first time you check in a business process model. Then, any time you check
it out later and check it back in again, check in a new version of this definition, unless you want to save
another copy of the business process model in the application, with a new name.

The name you assign in the process definition is the identifiable name used to indicate the process
throughout the application interface and the application and GPM Source managers.

About Checking in Business Process Models

You can check in a business process model from within the GPM interface or through the application
interface.

Both the application interface and the GPM provide a Source Manager feature you use to check in a business
process. The two Source Managers differ slightly, but both enable you check in new business process
definitions and new versions of previously checked-in process models. Both display the current list of
business process models and versions.
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Each time you check in a business process, you create a version of the business process, either the first
version of a new process model, or a new version of a previously checked-in business process model. The
application saves each checked in version so that you retain a copy of every iteration of a process model that
you check in. You cannot check in a version of a business process that is checked out and locked (protected)
by another user.

The check in procedure differs depending on your goal and the application you are using. The following

table describes the options and provides a link to appropriate instructions:

Type of Check-In

For Instructions, see:

Check in a new business process model in the GPM

Note: This applies to both original process models and any
modified models you want to check in as a new process
rather than as a version of an existing one)

Checking In a Single Business Process Model
in the GPM

Check in new version of a business process model in the GPM

Checking In a New Version of a Business
Process Model in the GPM

Check in multiple business process models in the GPM

Checking In Multiple Business Process Models
in the GPM

Check in new business process model in the application interface

Note: This applies to both original process models and any
modified models you want to check in as a new process
rather than as a version of an existing one.

Checking In a New Business Process Model
Using the application Interface

Check in new version of a business process model in the
application interface

Checking In a New Version of an Existing
Business Process Version in the application

Check in a new or modified business process model from the text
editor in the application

Checking In a Business Process Model Using
the Text Editor

Testing the Business Process Model

Test your business process model before using it in your production environment. The validation step
verifies only that the BPML structure is valid, it does not indicate invalid parameters or guarantee that the

process works, so testing is important.

Use a test environment if possible. If the application reports errors, make appropriate corrections to the

business process model or the service and adapter configurations in it. Retest the business process until it is
working as needed in the test environment.

When you are ready to implement the business processes in your production environment, you can export
the resources from the test environment and import them into production. The ability to tag resources can
expedite the automation of the export and import process.

Remember that the flexibility of the application often enables you to choose from among many options to
accomplish a given task. Test cycles will help you determine the most efficient methods for your needs.

For instructions for testing a business process model, see Testing a Business Process Model.
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Business Process Model Processing Options

When you check in a business process model, the system prompts you to set a variety of processing options.
You can configure archiving of related data, document storage and tracking, persistence levels, and many
other features, according to your business needs. If you are using a clustered installation of the application,
you can specify the specific node you want the process to run on.

Your selections may affect system performance, error handling, amount and type of data available for
monitoring events, and so forth, so be sure to review the options described here before you check in a
business process model, and determine which selections are appropriate for your needs (you can modify
them as needed later by re-checking in the process model).

Remember that some processing options can be set at the global level for the entire system and some within
the BPML for a process model. These settings may or may not override settings you make at the business
process level, depending on the options you choose. The field descriptions indicate which settings override
other settings.

Process Name

Field Description

Process Name Type a name that identifies the business process model.
This is the business process definition name stored in the application.

Description
Field Description
Description Type a description that helps identify the business process you are creating. This is

stored in the application with the version of the business process model you are checking
in. If the process model is an updated version of a business process, you may want to
note what you changed in this version, such as "added onfault step,” to help with future
differentiation between checked-in versions.

Process Levels

Field Description

Document Tracking Select this option if you want documents involved in this process model to be trackable
according to the document tracking settings you have configured. Document tracking at
the business process level is disabled by default, and this setting overrides the global
document tracking setting. If you are not using the application document tracking
features, leave the option disabled, to reserve system resources for other tasks.
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Field

Description

Set onfault processing

Select this option to the enable on-fault activity specified in the process to immediately
execute in the event of a system error.

Set Queue

The application enables you to set performance optimizations by queue, defining queue
levels the system uses to allocate resources. Select the queue level that you want for this
business process model for processing. The default value is 4.

Use BP Queueing

If selected, the bp is placed in a bp queue for processing. This is the default and
recommended method. To run the bp in BP Non-Queued mode, clear the
checkbox. In BP Non-Queued mode, however, the persistence level for the bp is
Zero by default, so the process cannot be manually restarted or resumed.

Enable Transaction

Select this option to instruct the application to treat the entire process as a single
transaction so that either all of the steps complete, or, in the event of an error, none of
them do. When an error occurs, no data is committed; data returns to its pre-process
state.

Note: Enabling transactions applies only to services that support transaction mode.
See the reference information for specific services to determine whether this
option is supported.

By default, this transaction mode is not enabled.

Note: If transaction management is already built into the process model (the model
includes Start and End Transaction services), do not select this option or the
process will fail.

Commit All Steps when
there is an error

Use only when the Enable Transaction field is checked. The default is selected (set to
true).

When a business process runs with the Enable Transaction option set to true, and an
error occurs, all steps up to the error step are committed if this field (Commit All Steps
when there is an error) is set to true.

If you clear the checkbox for this field (set it to false), all the steps up to the error step are
rolled back, with the exception of the first step (initial workflowcontext), and the error
step.

If all of the operations in the error step are transactional, they are also rolled back. For
example, if there is a Lightweight JDBC service in a business process that uses dbpool,
and the Lightweight JDBC service is using dbpool_local, then the operation is not rolled
back because it is non-transactional.

Category

You can optionally enter a category name to which this process model belongs, creating
the category. The category does not affect processing; categories are for future product
enhancements.
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Field

Description

Persistence Level

The persistence level options enable you to specify, at the business process level, the
types of data to retain in the database for the process whenever it runs. Persisted data
can be crucial to process recovery in the event of errors and is useful for monitoring and
tracking activities, including generating status reports. Persisted data may include any of
the following types of data:

¢ Status information for the steps in the process, which is comprised of:
- General status information for the steps (start and stop time, step name)
- Error information for failed steps
- Data describing the start and stop conditions of the process

¢ Process data

¢ Documents associated with the process

The types of data persisted for a process depends on the activities the process involves
(such as whether the process has documents associated with it) and your persistence
level settings.

Persistence can also be set globally (at the system level) for all processes; by default this
is set to FULL persistence, although it may have been customized for your installation. If
your installation uses the default FULL persistence for the system, you generally do not
need to change persistence at the business process level unless you are seeking
performance improvements. For the process model you are checking in, your selection
here overrides the global persistence level set in the properties file.

Note: Two exceptions may affect your persistence selection. First, remember that
some services support only a limited selection of persistence settings,
regardless of the level of persistence you assign to the process model.
Second, any persistence overrides configured in the BPML for steps in the
process model override the setting you make here for the specified step or
steps.

Choose the option that provides the type of data you need for monitoring, tracking, and
recovery in the event of a failure. Remember that persisting data can slow system
processing by filling up the database. Consider your archive and purge settings in
addition to the amount and type of data you intend to persist.

For a detailed description of persistence setting options, see Persistence Options on
page 59.
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Field Description

Event Reporting Level Select the level of events to generate for this process. Events are actions that occur
within the system, such as adapters starting and stopping, business process status or
state changes, and errors and exceptions, that are configured to generate event data.
The application uses events for various features, such as event-driven notifications.
Note: Full event reporting is recommended to ensure that all of your system features

operate correctly. Minimal or no event reporting settings are options that can
improve system performance in some specialized circumstances; however,
you should use these options only upon recommendation from Sterling
Commerce Customer Support, when Support has determined that features
dependent on events are not needed.

The levels are:
¢ Full — Generate all configured events for the business process, including the
business process start and end time, start and end times for all services or adapters

running as a result of this business process, and any resulting errors and exceptions.
This is the default and recommended selection.

¢ Minimal — Generate events for the business process, including the business process
start and end time and any resulting errors and exceptions.

¢ None — Do not generate any event reporting.

Recovery Level Select the level of recovery for this business process if the business process should be
interrupted during execution. The levels are:

¢ Auto Resume — Resume the business process at the last point at which the business
process was persisted.

¢ Auto Restart — Terminate the current business process and restart it from the
beginning.

¢ Terminate — Terminate the business process.

¢ Manual — Take no action automatically. With this option, you must resume or restart
the business process manually. This is the default selection.

Document Storage Select the document storage type for document payload data written when the business
process runs. The options are:

¢ Database — Store documents in the database. Use this option for small documents or
when clustering without a clustered file system.

¢ File System — Store documents in the file system. This option may be best for large
documents (over 10 MB). Using this method, you must handle archiving and purging
the documents from your file system.

Note: Archiving and purging from the file system may require special handling.

¢ System Default — Use the option configured in the jdbc.properties file. This is the
default document storage setting for process models. As shipped, Database is the
document storage type configured in the jdbc.properties file; it may be modified for
your installation to use the file system.

* Inherited — When one document is created as a result of another, the new document
uses the previous document'’s storage type.

Sterling Commerce, Inc. 58



Business Process Model Processing Options

Field

Description

Enable BP Execution

Settings

This option displays only when you are using a clustered the application environment.

Select this option to display the available choices for specifying the node to run the
process on. If you do not specify a node, the system uses any available node. To select

a node:

1 Inthe Select Node field, select the node on which you want the process to run.

2 Inthe Execution Node Specific field, specify whether the process must run on
the selected node or can use others. Options are:

Preferred Node — Run the process on the selected node unless the node is
unavailable (inactive for some reason).

Mandatory Node — Always run the process on the selected node (if the node is
unavailable for some reason, the process will fail).

Note: The Execution Role Specific field is reserved for future use.

Persistence Options

The following table describes the persistence options and indicates the types of data persisted for each:

Persistence
Level

Description

Start and Services Errored
Stop Steps Steps
Steps Status Data
Data Data

Process
Data

Docs

Full

Retains all data for this business
process model. This selection uses the
most system resources of any
persistence level setting.

Yes Yes Yes

Yes

Yes

Step Status -
Engine May
Override

This is the recommended persistence
level for most process models because it
helps optimize performance while
providing a level of recovery suitable for
most business needs.

* Persists process data and documents
for service steps according to the
persistence level supported by the
service in the step.

Yes Yes Yes

Possibly*

Possibly*

BP Start
Stop -
Engine May
Override

Choose this level if you know you do not
need persisted status data for successful
processing. Because service level
settings override the selection, you may
have additional data in a recovery
scenario.

* Persists process data and documents
for service steps according to the
persistence level supported by the
service in the step.

Yes No Yes

Possibly*

Possibly*
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Persistence Description Start and Services Errored Process Docs
Level Stop Steps Steps Data
Steps Status Data
Data Data
System This is the default selected persistence  Possibly*  Possibly*  Possibly* Possibly*  Possibly*
Default level.
* Persists data according to the global
persistence setting configured in the
properties file.

Step Status  Choose this level if you need only status  Yes Yes Yes No No

Only information for each step and your
recovery needs do not depend on
additional data being saved.

BP Start Choose this level if your recovery needs Yes No No No No

Stop Only do not depend on data being saved for
the processing steps.

Zero This level does not persist any business No No No No No
process data you for recovery or process
tracking. Choose this level only if you are
certain you will not need the data.

Note: Zero persistence is available
only if the process is running
in Synchronous start mode.

Error Only Choose this level if you do not need Only in Onlyin Yes Onlyin Onlyin
tracking data for your process whenitis case of case of case of case of
successful and your recovery does not  errors errors errors errors
depend on process step data being
saved.
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Deadline Settings of the application

A Deadline Setting allows you to specify a time for a business process (that is not in a state of ACTIVE) to
move to the front of the queued business processes waiting to run. Doing this notifies the system to place
the business process in queue to move to the front of the queue. Every effort will be made to run the business
process at the front of the queue. If the business process in queue misses its queue and reaches the first and
second deadline, an exceptional event will be fired and posted to the dashboard. In order for you to receive
the notification, you need to define the event posted to dashboard by setting EnableDeadlines=true in
noapp.properties for each queue and define the eventrule in the eventrule.properties file.

EnableDeadlines.l=true for queue 1.

To set the Deadline Setting, set it for the number of hours or minutes from the business process start time.
By default deadline and notifications are not set. To modify a Deadline Setting, you must modify the
business process by checking the business process out, then check it back in.

Deadline Settings:
Select the appropriate setting.

Field Description

Do not set deadline Run the business process without a deadline for queued business processes. This is the
default selection.

To run a queued business process on a deadline, clear the check box.

Complete by Deadline Enables you to specify a deadline time, in hours and minutes, by which the business
process must complete once it is put in a queue.

Note: The deadline setting applies as long as the business process remains in a
queue and does not apply for running business process.

First Notification: Hours  Enables you to specify whether to receive notification before a business process

and Minutes deadline (as long as business process remains in a queue).
Second Notification: Enables you to specify whether to receive another notification before a business process
Hours and Minutes deadline (as long as business process remains in a queue).

Additional Setup Procedures for Deadline Notifications (for business processes in
gueue)

Deadline Notification also requires additional setup for these property files:
1. Uncomment rulel and rule2 in eventrules.properties

¢ Uncomment the following two sets of rules to turn the # on Event Notification.

name.rulel = RuleEventAbnormal

expression.rulel = "/event[contains (ExceptionLevel, &apos;Abnormal&apos;) or
contains (ExceptionLevel, &apos; ABNORMAL&apos; ) 1"

action.rulel.l = com.sterlingcommerce.neo.event.rule.BPSpawnerAction
priority.rulel = 3

name.rule2 = RuleEventExceptional

expression.rule2 = "/event[contains (ExceptionLevel, &apos;Exceptional&apos;) or
contains (ExceptionLevel, &apos; EXCEPTIONAL&apos; ) 1"

action.rule2.1l = com.sterlingcommerce.neo.event.rule.BPSpawnerAction
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2. Confirm rules listener setting in listenerStartup.properties.

* #rule listener

Listener.Class.3=com.sterlingcommerce.woodstock.event.listeners.rule.RulelListener

3. The user wishing to receive these notifications needs to belong to the following groups

¢ Abnormal Event Notifications

¢ Exceptional Event Notifications

Life Span

Use these options to:

4+ Indicate the length of time that data pertaining to each instance of this business process model will
remain in the system after the process has completed, to be available for monitoring, tracking and

reporting activities.

4+ Specify whether to archive or purge the process-related data when the life span expires.

Field

Description

Process Specific

Enter the number of days or hours, or days and hours combined, that data for each
instance of this business process model are permitted to remain in the system.

Expired Business
Processes should be

Select either Archived or Purged for expired data. Archived data is stored in your file
system.

System Default

Select this option if you want the data for instances of this business process model to
expire and be archived after two days. This option is configurable.

Set Default Version

This option displays only if you are checking in a business process model for which one or more other
versions are already saved in the application.

Field

Description

Default Version

Indicates the version of this business process model that is currently saved and
designated in the system as the default version (the version the system runs unless
otherwise specified).

If you do not want this version of the process model to remain the default, select the
version you are checking in, in the OTHER Versions field.

OTHER Versions

Lists the version you are checking in and any other versions saved in the application.
Select the version you want to be the default.
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Confirm
Field Description
Enable Business Makes the process model available to run. The business process model is enabled by
Process default. If you are not ready to run the process, clear the check box.

Release the lock onthe  (Displays only if you are checking in a new version of a pre-existing process model that is
file locked.) Clear the check box if you want the pre-existing version of the process model to
remain locked.

Create Permission Select this option to have a permission selection created for this business process model
automatically. The permission can be assigned to user accounts to enable or restrict
user access to running the process. Permissions are optional. If none are assigned, the
process is available for all users.

Checking In Business Process Models Through the GPM

Checking in business process models involves setting a variety of processing options. Before you check in
a business process model, determine the appropriate options. For information, see Business Process Model
Processing Options.

The check-in procedure you use with the GPM Source Manager differs somewhat depending on what you
need to do. Select the procedure that applies to your situation:

4 Checking In a Single Business Process Model in the GPM
4 Checking In Multiple Business Process Models in the GPM
4 Checking In a New Version of a Business Process Model in the GPM

Checking In a Single Business Process Model in the GPM

This procedure assumes that you have validated and saved the business process model using the GPM.
To check a single business process model in to the application:

1. Inthe GPM, select Tools > Source Manager.

2. Type the same user ID and password that you use when logging in to the application.

3. In Source Manager, select Process > Add.

For the remaining steps, the order of the fields that display may differ, depending on whether your
GPM settings specify Expert Mode for the Source Manager. If you did not specify Expert Mode, click
Next to display the following fields.

4. Enter the appropriate values in the following required fields:

*  Process Name — see Process Name.
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+ File Name — Browse to select the business process document (.bp file) from the directory on your
client computer where you saved it.

+ Description — see Description.

+ Start Mode — see Use BP Queueing.

¢ Transaction Level — see Enable Transaction.

¢ Set Queue — see Set Queue.

+ Persistence Level — see Persistence Level.

+ Event Reporting Level — see Event Reporting Level.
+ Recovery Level — see Recovery Level.

+ Document Storage — see Document Storage.

+ Preferred Node — If you are using a clustered environment of the application and you want to
assign a specific node on which you prefer this process model to run, select the node. Otherwise,
the field defaults to a value of None. For more information, see Enable BP Execution Settings.

+ Mandatory Node — If you are using a clustered environment and you want to assign a specific node
on which this process model must run, select the node. Otherwise, the field defaults to a value of
None. For more information, see Enable BP Execution Settings.

¢ Category — see Category.
5. Indicate deadline settings for the business process to run. See Deadline Settings of the application.
Indicate archiving information for the data you are retaining. See Life Span.
Select validation options:
¢ Select Validate Process to validate the process model now.

Validate Process is activated by default, but is optional. Successfully validated business process
models are checked in and enabled for use in the application. When validation errors occur during
GPM check-in, Source Manager checks the model in, but it will not be enabled for use, and errors
are not reported. Therefore, be sure to validate the process before checking it in. Otherwise, a
process containing validation errors cannot be invoked until the errors are resolved.

¢ Select Enable Process to enable the business process to run in the application. If Validate
Process is not selected, you cannot enable the business process model.

If you do not enable the business process, you cannot run it in the application without first
enabling it later. For instructions to enable it independently of the check-in procedure, see Enable
a Disabled Business Process.

8. Specify whether you want the application to track the progress of the document when the business
process runs. See Document Tracking.

9. Specify whether you want the business process to run its onFault protection should the business
process encounter an error when it is running. See Set onfault processing.

10. Click Finish.

You can now run your business process in the application. Test the business process before running it in
your production environment. For information, see Testing a Business Process Model.
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Checking In Multiple Business Process Models in the GPM

You cannot specify processing options for individual business process models when you check in more than
one of them in the same check-in procedure. However, this method can be convenient when you do not need
to set the options. For details about the processing options you can set when you use the single check-in
procedure, see Business Process Model Processing Options.

Before adding multiple business processes at the same time, consider that:

4+ The application automatically sets each business process model you are checking in as the default
version for that process model, and enables it for execution. Do not check in multiple process models if
you do not want each of them to be the default processes.

4+ Aninvalid business process cannot be selected as a default business process, therefore the application
does not check in multiple process models if one or more of the models you are checking in has not
been successfully validated.

4+ The application applies the system default archiving configuration already defined in the application to
each business process, including:

+ The queue setting (this allocates resources related to the order in which business processes are
processed)

+ Level of persistence for retaining business process data

¢ Length of time (days and hours) to retain archived business process data

Procedure
To check multiple business process models in to the application at the same time:
1. For each business process model that you want to check in:

¢ Open the file.

+ Validate the process model (select Build > Validate).

If any business process model is invalid, Source Manager prevents you from checking in multiple
business processes at the same time.

+ Save the process model (.bp file).
Save all of the files in the same directory on your client computer.
2. Inthe GPM, select Tools > Source Manager.

In the Log In dialog box, type the same user ID and password that you use when logging in to the
application.

4. In Source Manager, select Process > Add All.

In the Directory field, specify the path to the directory from your client computer where you saved the
business process models (.bp files). To do this, click ... to browse to the folder, if needed. Click on the
folder name that contains the files, and click Select, without opening the folder. Then the contents of
the selected folder display in the left pane for you to select in the next step.

6. From the left pane, complete one of the following steps:

+ To select one business process model at a time from the directory, select the .bp file, and then click
the right arrow. Repeat as necessary.
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+ To add all the business process models from the directory at once, click the right double-arrows.
7. Click OK.

You can now run your business process models in the application. Test the business processes before
running them in your production environment. For information, see Testing a Business Process Model.

Checking In a New Version of a Business Process Model in the GPM

This process assumes that you have checked out a business process model and modified and validated it.
To check in an updated version of a previously checked-in business process in the GPM:
1. Inthe GPM, select Tools > Source Manager.

2. In Source Manager, select the business process model name from the left pane (not the version) to
check in, and select Process > Check In.

If the Check In option is not active, one of the following is true:
* No version of the selected process model is currently checked out.

* You have not refreshed the Source Manager with the most current list of process models (that is,
since you checked out a new version). To do this, select View > Refresh.

3. Complete the following required fields:

For the following fields, your display may differ, depending on whether you specified Expert Mode for
the Source Manager through the GPM. If you did not specify Expert Mode, click Next to display the
following fields.

*  Process Name — see Process Name.

+ File Name — Select the business process document (.bp file) from the directory on your client
computer where you saved it.

+ Description — see Description.

¢ Set Queue — see Set Queue

+ Persistence Level — see Persistence Level.

¢ Event Reporting Level — see Event Reporting Level.

¢ Recovery Level — see Recovery Level.

¢ Document Storage — see Document Storage.

Indicate deadline settings for the business process to run. See Deadline Settings of the application

Indicate whether you want this version to be the default version that the application runs. If you want a
different version to be the default version, select Let me select a different version, select the version
you want from the display, and click Next.

Indicate archiving information for the data you are retaining. See Life Span.
7. Select validation options:

¢ Select Validate Process to validate the process model now. You cannot check in if you do not
validate.
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¢ Select Enable Process to enable the business process to run in the application. If Validate
Process is not selected, you cannot enable the business process model.

If you do not enable the business process, you cannot run it in the application without first
enabling it later. For instructions to enable it independently of the check-in procedure, see Enable
a Disabled Business Process.

+ Indicate whether you want to release the lock on this process model so that it can be run in the
application or modified by other users.

8. Specify whether you want to track the progress of the document when the business process runs.
Document Tracking on page 55.

9. Specify whether you want the business process to run its onFault protection should the business
process encounter an error when it is running.

10. Click Finish.

You can now run your business process in the application. Test the business process before running it in
your production environment. For information, see Testing a Business Process Model.

Checking In a Business Process Model Using the Text Editor

You check in a business process model using the application text editor only if you are creating or modifying
the model in the editor. You can indicate whether the want the model to be the default model.

This check-in option is part of the larger process of creating or modifying a business process model using
the text editor. For information, see the appropriate procedure:

4+ Creating and Modifying Business Process Models In the Text Editor
4+ Modifying a Business Process Model Using the Text Editor

Checking In a New Business Process Model Using the
application Interface

Use this procedure if you want to check in a process model that you:

4 Just created and saved in the GPM

4+ Checked out of the application, modified and saved in the GPM, and want to check into the application
as a new business process model (not as a version of an existing model)

Before you check in a business process model, consider the processing options you will want to associate
with it. For information, see Business Process Model Processing Options.

To use the application interface to check in a new business process model saved in the GPM:
1. From the Business Process menu, select Manager.
2. Inthe Create section, click Go!
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10.

11.

12.

13.

14.
15.

16.

17.
18.

Checking In a New Version of an Existing Business Process Version in the application

Type a name that helps identify the business process definition you are creating. See Process Name.

Under Select an input mode for defining the new process, select Check-in Business process created
by the graphical modeling tool and click Next.

Select the business process document (.bp file) from the directory on your client computer where you
saved it.

Type a description that helps identify the business process you are creating and click Next. See
Description.

Specify whether you want to track the progress of the document when the business process runs. See
Document Tracking.

Specify whether you want the business process to run its onFault protection should the business
process encounter an error when it is running. Set onfault processing

For Set Queue, indicate the queue, previously defined to allocate resources, at which to place this
business process for processing. See Set Queue.

Indicate the level of persistence to retain data that makes up the business process. See Persistence
Level.

Indicate the level of event reporting that you would like or this business process when it runs. See
Event Reporting Level.

Indicate the level of recovery for this business process if the business process should halt during
execution. See Recovery Level.

Indicate the level of document storage for documents that process when the business process runs. See
Document Storage.

Indicate deadline settings for the business process to run. See Deadline Settings of the application.

Click Next and indicate the life span (archiving information) for the level of persistence data you are
retaining. See Life Span.

To enable the business process to run, click Next, and verify that the check box next to Enable
Business Process is selected.

To create a permission, select Create Permission, and then click Finish.
Click Finish.

Checking In a New Version of an Existing Business Process
Version in the application

Use this procedure to check in a new version of business process model that has been previously saved in
the application (meaning, it already has a business process definition) and that has now been modified.
During checkin you will indicate which saved version will be the default version.

Note: You cannot check in a new version of a business process model if you do not own the lock on the

pre-existing model; that is, if you are not the user who checked the process model out prior to this
attempt to check in the new version.
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To check in a new version of an existing business process model:

1.
2.
3.

10.

11.

12.

13.

14.
15.

16.
17.

18.

19.

20.

21.

From the Business Process menu, select Manager.
Use the List or Search options to locate the process model you want to check in.

Next to the name of the business process model for which you are checking in a new version, click
source manager.

Click Go! next to Check-in an updated definition for this Business Process.

You can also click check-in next to a business process to disable the lock and check in a business
process.

Select the business process document (.bp file) from the directory on your client computer where you
saved it.

Type a description that helps identify this version of the business process. See Description.

Specify whether you want to track the progress of the document when the business process runs. See
Document Tracking.

Specify whether you want the business process to run its onFault protection should the business
process encounter an error when it is running.

For Set Queue, indicate the queue level. See Set Queue.

Indicate the level of persistence to retain data that makes up the business process. See Persistence
Level.

Indicate the level of event reporting that you would like for this business process. See Event Reporting
Level.

Indicate the level of recovery for this business process if the business process should halt during
execution. See Recovery Level.

Indicate the level document storage for documents that process when the business process runs. See
Document Storage.

Indicate deadline settings for the business process to run. See Deadline Settings of the application.

Click Next and indicate the life span (archiving information) for the level of persistence data you are
retaining. See Life Span.

To compile the business process data, click Next.

To make this business process the default version, click Next and select the business process under
OTHER Versions.

To enable the business process to run, click Next and verify that the check box next to Enable
Business Process is selected.

If you choose not to enable this business process, clear the Enable Business Process check box.

To unlock the business process, verify that the check box next to Release the lock on the file is
selected.

To create a permission associated with this business process model, select Create Permission, and
click Finish.

Click Finish.
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Testing a Business Process Model

Before running it in your production environment, test a new business process model or new version of a
process model by manually running it, or configure it to run on a schedule. If possible, test your business
process in a test environment of the application.

One testing method is to test the business process using sample input data by starting the business process
manually.

Retest the business process until it is working as needed.

Procedure
This process assumes that you have checked in and enabled the business process model that you are testing.
To test a business process:

1. From the Business Process menu, select Manager.

2. Type all or part of the name for the business process you want to test into the Search box and click
Gol!

Next to the business process you want to test, click execution manager.

4. On the Execution Manager page, ensure that the business process you want to run is enabled and set as
the default version.

5. Click execute to open the Execute Business Process Input page.
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6. Specify the following input parameters, as appropriate, and click Go!:

Field Description
Local Desktop Name of your client computer where the file is stored. If it is stored on the client computer,
filename select a directory on your client computer where the file is stored. If the file is stored on the

host computer, go to the UNIX command line and type the command to specify the directory
where the file is saved. Optional.

Note: If you use a 0 (zero) byte file as the primary input document on the Execute
Business Process Input screen, the following message appears: File was not
found or is empty, select another file. If the business process needs to be executed
with a zero-byte file, use the File System adapter to get the file.

Server filename Name of the host server for your client computer. Optional

Encoding Type Character encoding for the business process. Optional. Valid values are:
¢ [Not Applicable]
¢ UTF-8 ISO-8859-1

¢ |S0-8859-5
¢ US-ASCII
¢ |SO_8859-1

¢ EUC-JP UTF-16
¢ |SO-2022-JP

Run As User Assume user-rights of another user in order to run this particular business process. The
default user is Admin; therefore, if you do not change the user in this field, whomever runs
this business process will have the same rights as an admin user. Optional.

Input data is not File the business process requires as input. Optional.
required, click Go to
continue.

The application runs the selected version of the business process and opens the Execute Business
Process page.

After you initiate the process model, you can monitor the processing activities.
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Business Process Version Management

Both Application interface and the GPM provide access to work with your process models through the
Source Manager. The Source Manager is a version management tool for saving copies of your process
models into Application system, separately from any location on your client computer where you may have
also saved them. It works as follows:

4+ When you create a process model, you cannot run it in Application until you have checked it in. The
check-in procedure stores it for the Source Manager.

4+ While you can save process model .bp files to your client computer at any time, to manage versions in
Application you must use the Source Manager as your file management system.

4+ To work with existing business process models, you must check them out through the Source Manager
in order to lock the model against other users modifying it at the same time.

Note: If you click Edit in the interface and modify a process model without checking it out, this locks
the process.

4+ When you complete your modifications, you check in the now-updated process model. Rather than
over-writing your existing copy of the model saved in the Source Manager, the system saves a new
version.

Application saves all previously checked-in versions of business process models. Therefore, a single
process model may have many available versions listed in the Source Manager. One version is the
designated default version. The default version is the version that Application automatically runs when the
business process model is invoked. Retention of all versions enables you to revert to using an older version
should the need arise, and saves you having to maintain versioned backup files on your client computer.

The Source Manager determines versions by filename, as follows:

4+ While separate versions of a process model are different configurations, the filename of each is the
same.

4+ In the Source Manager, the system displays the date and time each version was checked in, to help you
differentiate them.

4 You can add additional identifying information in the Description field when you check in a process
model to include more reference data about a version, such as indicating the need this version fills.
This information displays in the Source Manager list in the interface.
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4 Assigning a new name to a process model at check-in creates a new model. The new model will have
its own set of versions if you make additional changes to the file.

Working in the GPM, the Source Manager displays a file system-type list of the process models saved in
the system. Working in the interface, you use search or list tools to locate a process model and access the
source manager for the selected process model. The following figure illustrates the Source Manager:

GPM
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'3*ﬁAFTRDutePackageDocument
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Interface
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Check-in an updated definition for this Business Process Delete Selected Versions
Delete All Versions
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When you check in an updated version of a business process model, you indicate which version is the default
version in Application.

The ability to specify a default version enables you to let bootstrap adapters run the default version of a
business process model as needed, while other versions can be reserved for later use or be configured to run
on a preset schedule. Any time you manually start a business process, you can select the version to run.

Generally, when you check out a business process model, Application locks the process model so that other
users and the system can not access it until you check it back in. If you plan to use an existing business
process model as a foundation for a new model altogether, you can check out the model without locking it.
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For instructions for checking out business process models, making modifications, and managing your
versions of business process models, see the appropriate topic as indicated in the following table:

Task For Instructions, see:

Check out a business process model in the GPM Checking Out a Business Process Model Using the GPM
Source Manager

Check out a business process model in Application Checking Out a Process Model in Application Interface

interface

Modify a business process model in the text editor Modifying a Business Process Model Using the Text
Editor

Modify a business process model in the GPM Modifying a Business Process Model Using the GPM

Delete a business process model from Application Delete a Business Process Model

Enable a disabled business process version Enable a Disabled Business Process

Checking Out a Business Process Model Using the GPM
Source Manager

The Source Manager in the GPM enables you to check out one or many business processes at a time. Use
the appropriate procedure.
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The following figure shows an example of the GPM Source Manager:
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The GPM Source Manager displays an alphabetical list of checked-in business process models. You can
expand each process model name to view a list in the left pane of checked-in copies of that model, organized
by checkin date and time (these are versions of the business process model). The right pane displays the
following information for a selected version of a business process model:

4 Date and time the version was last modified
4 User name of the user who last saved the version
4+ Any description saved with the version at check-in

Check Out a Single Business Process Model

To check out a business process using the GPM:

1. From the Tools menu, select Source Manager.

2. Type the same user ID and password you use to log in to Application.

3. In Source Manager, select a business process and select Process > Check Out.

4. Specify a directory on your client computer in which to save the business process model (.bp file).

Note: If you specified a file location using the GPM preferences, you do not need to perform this step.
To set a default file location from the GPM, select Options > Preferences > File Location.

5. Indicate a new file name for the business process model when necessary. For example, to create a new
version of a business process, indicate a new name that helps identify the version. See Process Name.
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6. To prevent other users from checking out this business process, verify that the Lock Business Process
option is selected. If you do not want to lock the process, clear the check. If you are creating a new
business process model but want the model you are checking out to remain as-is in Application, you do
not need to lock the process model.

A lock symbol displays beside the business process when protected.

7. Click OK twice. The business process is checked out and you can open it in the GPM by:
¢ Selecting File > Open
+ Navigating to the directory where you saved the checked-out model

¢ Selecting the model and clicking Open.

Check Out Multiple Business Process Models

To check out multiple business processes at once:

1. From the Tools menu, select Source Manager.

2. Inthe Log In dialog, enter your Application user ID and password.

3. In Source Manager, double-click the parent folder to display all business processes in the right pane.
4. Complete one of the following steps:

¢ To select more than one business process, click to select the business process from the right pane.
Press and hold Ctrl and click again for each additional business process that you want to select.

+ To select a range of business processes, click the first business process in the range from the right
pane. Press and hold Shift and click the last business process in the range.

From the Process menu, select Check Out.
Specify a directory on your client computer in which to save the business process models.

7. To prevent other users from checking out these business processes, verify that the Lock Business
Process option is selected and click OK.

A lock symbol displays beside the business process when protected.

Checking Out a Process Model in Application Interface

When you check a business process model out of Application, you save it to your client computer. You can
then open the checked-out .bp file in the GPM (editing a business process model in the interface uses a
different check-out procedure; for that procedure, see Modifying a Business Process Model Using the Text
Editor).

During the check-out procedure, Application prompts you to lock the business process. Locking the
business process not only prevents others from checking out the same business process, it also prevents the
possibility of inadvertently replacing an existing business process. If you do not lock the process in
Application, you cannot check in a new version of it, although you can check it in as a new process model.
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You can also check out a read-only copy of the process model. Using the read-only copy enables you to
view and modify the business process model (in the GPM only, until you check it in to Application), but
you must save it with a new name. Use this option if you want to create a new business process model using
an existing one as the basis for it.

Procedure

To check out a business process model:
1. From the Business Process menu, select Manager.

2. Type all or part of the name for the business process you want to modify into the Search box and click
Go!

Click source manager next to the business process you want to modify.
4. Click check out next to the business process.
Determine whether to lock the file by completing one of following steps:

+ To check out the business process for modification, click OK. Use this option to create an updated
version of the process model in the GPM or the text editor.

+ To check out a read-only copy of the business process without locking it, click Cancel. Use this
option to view the model in the GPM or to use it as the foundation for a new business process
model (in this case you must open it in the GPM and save it with a new name).

6. Inthe File Download dialog box, click Save.

7. Inthe Save as dialog box, select a directory on your client computer and click Save to begin
downloading the business process document.

When the download completes, close the Download dialog box, if it remains open.

9. Open the directory where you downloaded the file for the business process and open the file in the
GPM to begin modifying it.

After you have modified a business process model, you must check it back in to Application so that you can
run it. For information, see Implementing a Business Process Model.

Modifying a Business Process Model Using the GPM

To modify or reuse a business process that is currently checked in to Application:

1. Check out the business process. See Checking Out a Business Process Model Using the GPM Source
Manager.

The check-out process enables you to save the business process to your client computer. You can then
open the checked-out .bp file in the GPM and modify the business process model. You can change the
processing options for the model when you check it back in, if needed (in step 3 below).

2. Follow the general instructions for business process creation to modify your business process model
(see Creating or Modifying a Business Process Model in the GPM).
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3. When finished, check the new version in to Application. For information about implementing new
versions of business process models, see About Checking in Business Process Models.

Modifying a Business Process Model Using the Text Editor

Note: If you do not need to modify the BPML but only need to change processing options, skip step 6. By
doing this, you check the process out and then immediately begin the check-in procedure where you
can set the processing options.

To modify a business process model in the text editor:
1. From the Business Process menu, select Manager.

2. Type all or part of the name for the business process you want to edit into the Search box and click
Gol!

Click source manager next to the business process you want to edit.

Click edit next to the business process to access the text editor. This checks out the process and locks
it.

5. Type a new description that helps you identify this version of the business process. See Description on
page 55.

6. Inthe Business Process field, either type or copy and paste BPML code that you want to edit.

Click Validate to validate the process model. You cannot enable a business process until it is
validated.

A system message indicates whether the process is valid or invalid.
8. Is the process valid?

¢ If No, correct invalid BPML code and repeat step 7 as necessary. You can view error information
by clicking the link in the error message.

* |f Yes, click Next.

9. Specify whether you want to track the progress of the document when the business process runs. See
Document Tracking on page 55.

10. Specify whether you want the business process to run its onFault protection should the business
process encounter an error when it is running.

11. For Set Queue, indicate the queue, previously defined to allocate resources, at which to place this
business process for processing. See Set Queue.

12. Indicate the level of persistence to retain data that makes up the business process. See Persistence
Level.

13. Indicate the level of event reporting that you would like for this business process. See Event Reporting
Level.

14. Indicate the level of recovery for this business process if the business process should halt during
execution. See Recovery Level.
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15. Indicate the level document storage for documents that process when the business process runs. See
Document Storage.

16. Indicate deadline settings for the business process to run. See Deadline Settings of the application.

17. Click Next and indicate the life span (archiving information) for the level of persistence data you are
retaining. See Life Span.

18. To compile the business process data, click Next.
19. To enable the business process, verify that Enable Business Process is selected.

If you do not enable the business process, you can not run it in Application without first enabling it
later. For instructions to enable it independently of the check-in procedure, see Enable a Disabled
Business Process.

20. If you want to create a permission associated with the business process model, select Create
Permission, and then click Finish.

Enable a Disabled Business Process

Complete this procedure if you want to run a business process model that is disabled for use:

1. From the Business Process menu, select Manager.

2. Inthe List section, select the first letter of the name of the business process you need to enable, and
click Go!

Next to the name of the business process to enable, select Execution Manager.
4. Select Enable and click Return.

Delete a Business Process Model
In Application, you can delete individual business process models (except system business process). Some
reasons you might delete a business process model are:

4 Business activities have changed and as a result a process model can no longer accomplish the
activities.

4 You need to remove unused versions of business process models to reduce database size.

Not all users can delete business process models. The ability to delete is governed by a permission setting
in your user account. Only user accounts that have Ul Delete Business Processes permission can delete
business processes.

Considerations

Before deleting a business process model, consider that:
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4+ Deleting a business process model is permanent; you cannot restore a deleted process model. Use the
Export Resources function to save a copy of the business process to offline storage.

4+ If the business process model runs on a schedule, Application deletes the schedule with the business
process.

4+ After you confirm that you want to delete a business process (during the delete procedure), Application
deletes the business process and creates a log entry. The log entry contains the name of the business
process, date and time of deletion, and the account information of the user who deleted the business
process.

Procedure

Caution: ldentify any uses of the business process model to ensure that deleting it does not prevent other

business processes and subsequent services from running.

To delete an individual version of a business process or all versions of a business process:

1.
2.
3.

From the Business Process menu, select Manager.
Search for the business process you want to delete.

In the Business Process Manager search results page, click source manager next to the appropriate
business process model.

Do you want to delete one version of the business process, or all versions of the business process
model?

¢ To delete one version of the business process model:
a. Next to the version, under Delete, select the check box.
b. For Delete Selected Versions, click Go!

+ To delete all versions of this business process model, next to Delete All Versions, click Go!
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Appendix A

Commonly Used Predefined Process Models

To help you accomplish business goals, Application provides a number of predefined business processes
that you can use when creating business process models for your own business processes. After determining
business goals and identifying the activities that enable you to meet the goals, you can either use the
predefined business processes or create your own business processes.

This topic describes some common business goals and predefined business processes provided in
Application that enable you to easily achieve the goals. This section provides the following types of
information:

*
*
*
*

Description of each business process

Activities that each business process performs

Adapters and services that accomplish the activities

Specifications that Application may require before you can use a predefined business process

The following table lists business goals and the predefined business process that accomplishes the goals:

Business Goal Business Process For More Information,
See

Extracts ACH (Automated Clearing House) documents, such ACHDeenvelope ACHDeenvelope Business

as a Payment Order/Remittance Advice Transaction Set Process

(820), from an CTX interchange-level envelope and locates
an associated contract, according to the content of the
documents. ACHDeenvelope then starts the appropriate
business process.

Applies an CTX transaction-level envelope to one or more ACHEnvelope ACHEnvelope Business
ACH documents. Next, the ACHEnvelope wraps the Process

document in an CTX group-level envelope and wraps the

group-level envelope in an CTX interchange-level envelope.

ACH Envelope then uses the interchange-level envelope

data to locate the associated contract and start the

appropriate business process.

Extracts Cll messages from a message group in an EDI CliDeenvelope EDI Deenvelope Business
document. Application then reads the CIl message to Process
determine the next action to perform.
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Business Goal

Business Process

For More Information,
See

Extracts EDI documents from an EDIFACT interchange and
locates an associated contract, according to the content of
the envelopes. EDIFACTDeenvelope then starts the
appropriate business process.

EDIFACTDeenvelope

EDI Deenvelope Business
Process

Enables Application to process incoming SOAP messages. HandleSOAPReques HandleSOAPRequest
Business Process

Identifies EDI documents that maintain the state waiting in OverdueAckCheck OverdueAckCheck

Application. The state waiting often indicates that an Business Process

acknowledgment is overdue.

Enables Application to send SOAP messages. SendSOAPRequest SendSOAPRequest

Business Process

Extracts EDI documents from an ANSI X12
interchange-level envelope and locates an associated
contract, according to the content of the documents.
X12Deenvelope then starts the appropriate business
process.

With additional configuration, X12Deenvelope can also
reconcile TA1 and 997 reports and generate the interchange
TA1 and functional group 997 acknowledgments.

X12Deenvelope

EDI Deenvelope Business
Process

ACHDeenvelope Business Process

The ACHDeenvelope business process performs the following primary activities:

1. The ACHDeenvelope service splits documents into interchanges and puts delimiters sent into the

process data.

2. Depending upon configuration, the service either looks up a contract or runs a business process.
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The following figures show the Achdeenvelope business process model as it displays in the GPM:

The following BPML code makes up the Achdeenvelope business process:

<process name="ACHDeenvelope">
<rule name="BPOnError">

<condition>InvokeBPOnError/text ()='YES'</condition>

</rule>

<rule name="PostProcess">

<condition>InvokePostProcessBP/text ()='YES'</condition>

</rule>

<sequence>

<assign to="NACHA-Interchange" from="PrimaryDocument/@SCIObjectID"></assign>

<operation name="ACHDeEnvelope">
<participant name="DeenvelopeACH"/>
<output message="Xout">
<assign to="." from="*"></assign>
</output>
<input message="Xin">
<assign to="." from="*"></assign>
</input>
</operation>

<choice>
<select>

<case ref="PostProcess" activity="PostACHDeEnvelope"/>

</select>

<sequence name="PostACHDeEnvelope">
<operation>

<participant name="InvokeSubProcessService" />

<output message="Xout">

<assign to="INVOKE MODE">INLINE</assign>

<assign to="WFD_NAME" from="//SuccessBPName/text () "></assign>

</output>
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<input message="Xin">
<assign to="." from="*"></assign>
</input>
</operation>

</sequence>
</choice>
<onFault>
<choice>
<select>
<case ref="BPOnError" activity="ErrorBP"/>
</select>
<sequence name="ErrorBP">
<operation>
<participant name="InvokeSubProcessService" />
<output message="Xout">
<assign to="INVOKE_MODE">INLINE</assign>
<assign to="WFD_NAME" from="//ErrorBPName/text () "></assign>
</output>
<input message="Xin">
<assign to="." from="*"></assign>
</input>
</operation>

</sequence>
</choice>
</onFault>
</sequence>
</process>

Before Using the AchDeenvelope Business Process

Before you use the ACHDeenvelope business process, complete the following tasks:
1. Activate your license for the ACHDeenvelope service.
2. Create an ACH-CTX inbound envelope.

ACHEnNnvelope Business Process

The ACHEnNvelope business processes performs the following primary activities:

1. Starting with one or more EDI documents, the ACHEnvelope services applies CTX envelope
properties at the document level to each document, and then applies a message group header and trailer
for documents with CTX Rule requirements.

The ACHEnNvelope service takes one or more transaction sets and applies a functional group envelope.

3. The ACHEnNvelope service takes a functional group and applies the interchange-level envelope and
searches for a matching contract.
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4. Using the interchange-level envelope data, the service either looks up a contract or runs a business
process.

The following figures show the ACHEnNvelope business process model as it displays in the GPM:

The following BPML code makes up the AchEnvelope business process:

<process name="ACHEnvelope">
<rule name="contract">
<condition>CONTRACT_ FOUND = &quot;YES&quot;</condition>
</rule>

<sequence>
<sequence>
<operation>
<participant name="EnvelopeACH"/>
<output message="Xout">
<assign to="." from="*"></assign>
</output>
<input message="Xin">
<assign to="." from="*"></assign>
</input>
</operation>

<onFault>

<operation>
<participant name="BPExceptionService"/>
<output message="Xout">

<assign to="exceptionCode" from="'Translation Error'"></assign>

</output>
<input message="Xin">
</input>

</operation>

</onFault>

Sterling Commerce, Inc. 85



EDI Deenvelope Business Process

<onFault code="Translation-Error-Some-Docs">
<assign to="BREAK">YES</assign>
</onFault>
</sequence>
<choice>
<select>
<case ref="contract" activity="invoke_contract_workflow"/>
</select>

<sequence name="invoke_contract_workflow">
<operation>
<participant name="InvokeBusinessProcessService"/>
<output message="Xout">
<assign to="INVOKE_MODE">ASYNC</assign>
<assign to="." from="*"></assign>
</output>
<input message="Xin">
<assign to="." from="*"></assign>
</input>
</operation>

</sequence>
</choice>
</sequence>
</process>

Before Using the ACHENnvelope Business Process

Before you use the ACHDeenvelope business process, complete the following tasks:
1. Activate your license for the ACHenvelope service.
2. Create an ACH-CTX inbound envelope.

EDI Deenvelope Business Process

The EDI Deenvelope business process includes the EDI Deenveloping service to support non-printable
characters as EDI delimiters and perform the following steps:

1. Splits documents into interchanges and puts delimiters sent in the ISA (or UNA) into process data.

2. Starts the X12 Deenveloping, EDIFACT Deenveloping, or Cll Deenveloping business processes, as
appropriate.

If exceptions occur when running an EDI Deenvelope business process, Application generates an EDI
Compliance Report.
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The following figure shows the EDI deenveloping business process model as it displays in the GPM:

The following BPML code makes up the EDI deenveloping business process:

<process name="EDIDeenvelope">
<sequence>
<operation>
<participant name="EDIDeenvelope"/>
<output message="Xout">
<assign to="." from="*"></assign>
</output>
<input message="Xin">
<assign to="." from="*"></assign>
</input>
</operation>

</sequence>
</process>

The following scenario shows how the EDIDeenvelope business process can deenvelope ANSI X12
documents:

1. The File System adapter collects a file from an ANSI X12 collection folder and invokes the
EDIDeenvelope business process.

2. The EDI Deenveloping service determines that the file contains an X12 document and starts the
X12Deenvelope business process.

3. The X12Deenvelope business process removes the envelopes to make available the transaction set
envelope for the X12 document and determine the next action to perform.

4. For documents with CIlI Syntax Rule requirements, the X12Deenvelope business process parses the
message group and uses the values indicated in the message group header to locate a matching
envelope. The envelope then determines the next action to perform.

Note: If the X12Deenvelope business process does not locate a matching envelope, the business process
stops. Application generates an EDI Compliance Report that describes the reason that the
X12Deenvelope business process could not locate the envelope.

Before Using EDIDeenvelope

Before you use the EDIDeenvelope business process, you must complete the following tasks:
1. Create the trading profile, including a contract.
2. Create necessary envelopes.
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3. Create a business process that initiates the EDIDeenvelope business processes.

When creating a business process that enables inbound ST (or UNH) envelopes to translate
transactions when running EDIDeenvelope business processes, consider:

+ Delimiters sent in the ISA or UNA segments are placed into process data in Application.

+ The GPM makes available parameters that represent the delimiters, which you must configure to
enable the envelopes to translate transaction.

¢ You must create an XPath expression that describes the location of envelopes and apply it to the
Translation service.

OverdueAckCheck Business Process

The OverdueAckCheck business process identifies EDI documents that are waiting for an acknowledgment.
Most likely, an acknowledgment is overdue when an EDI document state indicates continuous waiting.
OverdueAckCheck produces a status report that lists details about EDI documents. You can use the report
to determine whether an acknowledgment is overdue.

The following figure shows the OverdueAckCheck business process model as it displays in the GPM:

The following BPML code makes up the OverdueAckCheck business process:

<process name="OverdueAckCheck">
<sequence>
<operation>
<participant name="OverdueAck"/>
<output message="Xout">
<assign to="." from="*"></assign>
</output>
<input message="Xin">
<assign to="." from="*"></assign>
</input>
</operation>

</sequence>
</process>

Before Using OverdueAckCheck

Before you use the OverdueAckCheck business process, you must specify in the envelope configuration that
you expect an acknowledgment.
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HandleSOAPRequest Business Process

The HandleSOAPRequest business process enables Application to receive SOAP messages. When
HandleSOAPRequest receives a SOAP message, HandleSOAPRequest validates the message, and then
reads the message to determine the receiver of the message.

If Application is the receiver of the message, HandleSOAPRequest performs this process:

1.
2.

Verifies the digital signature.
Removes the SOAP envelope and puts any attachments and SOAP header blocks into process data.

Application puts inbound SOAP message attachments in business process data under the node
SOAPRequestAttachments. The attachments follow this naming convention: SOAPAttachmentl,
SOAPAttachment2, and so on. Application sets the content ID attribute to what was specified in the
SOAP message.

Invokes indicated subprocesses.
Applies a SOAP envelope if necessary and HTTP headers to the document.
Returns a response to requestor.

If Application is not the ultimate receiver, HandleSOAPRequest performs this process:

© 0 k~ w Pk

Verifies the digital signature.

Removes SOAP header blocks that are specific to Application and puts them into process data.
Invokes indicated subprocesses.

Forwards a document to the next receiver.

Receives a response from the receiver.

Returns a response to the requestor.
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The following figures show the HandleSOAPRequest business process model as it displays in the GPM:

The following BPML code makes up the HandleSOAPRequest business process:

<process name="HandleSOAPRequest">
<rule name="acting_as_intermediate">
<condition>SOAP_INTERMEDIATE_NODE = &quot;true&quot;</condition>
</rule>

<rule name="acting_as_endpoint">
<condition>SOAP_INTERMEDIATE_NODE = &quot; false&quot;</condition>
</rule>

<sequence>
<sequence>
<operation name="SoapIn">
<participant name="SOAPInbound" />
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<output message="output">
<assign to="." from="*"></assign>
</output>
<input message="input">
<assign to="." from="*"></assign>
</input>
</operation>

<choice>
<select>
<case ref="acting_as_intermediate" activity="act_as_intermediate"/>
</select>

<sequence name="act_as_intermediate">
<assign to="xport-http-url" from="NextSoapURL/text()"></assign>
<sequence>
<operation name="HTTP Client Begin">
<participant name="HTTPClientBeginSession"/>
<output message="HttpClientBeginServiceInputMessage">

<assign to="." from="PrimaryDocument"></assign>
<assign to="RemoteURL" from="xport-http-url/text()"></assign>
<assign to="HTTPClientAdapter">HTTPClientAdapter</assign>
</output>
<input message="inmsg">
<assign to="." from="*"></assign>
</input>
</operation>

<operation name="HTTP Client Post">
<participant name="HTTPClientPost"/>
<output message="HttpClientPostServiceInputMessage">
<assign to="." from="PrimaryDocument"></assign>
<assign to="SessionToken" from="SessionToken/text ()"></assign>
<assign to="RawResponse'">true</assign>
<assign to="RawRequest"

from="xport-force-b2b-raw-message/text () "></assign>
</output>
<input message="inmsg">
<assign to="." from="*"></assign>
</input>
</operation>

<operation name="HTTP Client End">
<participant name="HTTPClientEndSession"/>
<output message="HttpClientEndServiceInputMessage">
<assign to="SessionToken" from="SessionToken/text ()"></assign>
</output>
<input message="inmsg">
<assign to="." from="*"></assign>
</input>
</operation>

<onFault>
<sequence>
<operation name="HTTP Client End">
<participant name="HTTPClientEndSession"/>
<output message="HttpClientEndServiceInputMessage">
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<assign to="SessionToken" from="SessionToken/text ()"></assign>

</output>
<input message="inmsg">
<assign to="." from="*"></assign>
</input>
</operation>

<assign to="SOAPfaultcode">Server</assign>
<assign to="SOAPfaultstring">There was an error processing the SOAP
request.</assign>
<assign to="SOAPdetail">An error occurred trying to send SOAP request
to next node.</assign>
</sequence>
</onFault>
</sequence>
<operation name="SoapIn">
<participant name="SOAPInbound"/>
<output message="output">

<assign to="." from="*"></assign>
<assign to="bootstrap">false</assign>
</output>
<input message="input">
<assign to="." from="*"></assign>
</input>
</operation>
<assign to="SOAPOutboundAttachments" from="SOAPResponseAttachments/*"></assign>
</sequence>
</choice>
<choice>
<select>
<case ref="acting_as_endpoint" activity="act_as_endpoint"/>
</select>

<sequence name="act_as_endpoint">
<operation>
<participant name="InvokeBusinessProcessService"/>
<output message="Xout">
<assign to="." from="*"></assign>
<assign to="INVOKE_MODE">SYNC</assign>
</output>
<input message="Xin">
<assign to="." from="*"></assign>
</input>
</operation>

<onFault>
<sequence>
<assign to="SOAPfaultcode">Server</assign>
<assign to="SOAPfaultstring">There was an error processing the SOAP
request.</assign>
<assign to="SOAPdetail">An error occurred while processing the SOAP
request.</assign>
</sequence>
</onFault>
</sequence>
</choice>
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<onFault code="SOAP-FAULT">
<assign to="InvokeSubBP">false</assign>
</onFault>
</sequence>
<operation name="SoapOut">
<participant name="SOAPOutbound"/>
<output message="output">

<assign to="." from="*"></assign>
<assign to="SOAP_MODE">respond</assign>
</output>
<input message="input">
<assign to="." from="*"></assign>
</input>
</operation>

<assign to="doc-has-headers">true</assign>
<operation name="HttpResponse">
<participant name="HttpRespond"/>
<output message="Xout">
<assign to="." from="*"></assign>
</output>
<input message="Xin">
<assign to="." from="*"></assign>
</input>
</operation>

</sequence>
</process>

Before Using HandleSOAPRequest

HandleSOAPRequest Business Process

Before you use the HandleSOAPRequest business process, you must complete the following tasks:

4+ Configure the SOAP Inbound service.

4+ Configure a related B2B HTTP Server adapter so that it is configured for raw messages, has the same
URI as the SOAP Inbound service, and is associated with the HandleSOAPRequest business process.

4 Create the business process that processes the SOAP message where Application is the final receiver.
Depending on your needs, you may need to assign values to several parameters before using the

HandleSOAPRequest business process.

The following table identifies parameters for various SOAP functions and the values you must specify:

Required SOAP Function SOAP Parameter

Parameter Values

SOAP enveloping on primary document ADD_SOAP_ENVELOPING

before posting

True = add SOAP enveloping (default).

Digitally sign a SOAP message SIGN_WITH_KEY

Type the exact name of the digital
certificate.

Envelope namespace prefix for SOAP ~ SOAPEnVNSPrefix
message

Type the envelope nhamespace prefix.
ADD_SOAP_ENVELOPING must also be
true.
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Required SOAP Function SOAP Parameter Parameter Values

Distinguish whether expected response  RESPOND_NON_SOAP True = response is not a SOAP message.
is a SOAP message False = response is a SOAP message.
Envelope namespace for SOAP SOAPENnVNSURI Type the envelope namespace.

message

SendSOAPRequest Business Process

The SendSOAPRequest business process enables Application to send SOAP messages.
When Application sends a SOAP message, SendSOAPRequest performs the following process:
1. Applies a SOAP envelope to the data, if requested.

2. The SendSOAPRequest business process adds SOAP headers to an outbound request if the process
data contains SOAP headers. The business process takes all subordinate nodes under the
SOAPHeaders node in process data and adds them as SOAP header blocks.

3. The SendSOAPRequest business process adds SOAP attachments to an outbound request if the
process data contains SOAP outbound attachments. The business process takes all subordinate nodes
under the SOAPAttachments node, which are named SOAPAttachmentl, SOAPAttachment2, and so
on. These nodes must have a ContentlD attribute specified, as well.

Sends the SOAP message to a receiver using HTTP.

4
5. Receives a response.

6. Acknowledges a response.
7

Provides a response to another business process in Application.

The following figures show the SendSOAPRequest business process model as it displays in the GPM:

The following figure continues the business process model of the SendSOAPRequest business process:
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The following BPML code makes up the SendSOAPRequest business process:

<process name="SendSOAPRequest">
<sequence>
<operation name="SoapOut">
<participant name="SOAPOutbound" />
<output message="BPML:output">

<assign to="." from="*"></assign>
</output>
<input message="input">

<assign to="." from="*"></assign>
</input>

</operation>

<sequence>
<operation name="HTTP Client Begin">
<participant name="HTTPClientBeginSession"/>
<output message="HttpClientBeginServiceInputMessage">
<assign to="." from="PrimaryDocument"></assign>
<assign to="RemoteURL" from="xport-http-url/text()"></assign>
<assign to="HTTPClientAdapter">HTTPClientAdapter</assign>

</output>
<input message="inmsg">
<assign to="." from="*"></assign>
</input>
</operation>

<operation name="HTTP Client Post">
<participant name="HTTPClientPost"/>
<output message="HttpClientPostServiceInputMessage">
<assign to="." from="PrimaryDocument"></assign>
<assign to="SessionToken" from="SessionToken/text ()"></assign>
<assign to="RawResponse">true</assign>
<assign to="RawRequest" from="xport-force-b2b-raw-message/text()"></assign>

</output>
<input message="inmsg">
<assign to="." from="*"></assign>
</input>
</operation>

<operation name="HTTP Client End">
<participant name="HTTPClientEndSession"/>
<output message="HttpClientEndServiceInputMessage">
<assign to="SessionToken" from="SessionToken/text()"></assign>
</output>
<input message="inmsg">
<assign to="." from="*"></assign>
</input>
</operation>

<onFault>
<sequence>
<operation name="HTTP Client End">
<participant name="HTTPClientEndSession"/>
<output message="HttpClientEndServiceInputMessage">
<assign to="SessionToken" from="SessionToken/text()"></assign>
</output>
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<input message="inmsg">
<assign to="." from="*"></assign>
</input>
</operation>

</sequence>
</onFault>
</sequence>
<operation name="SoapIn">
<participant name="SOAPInbound" />
<output message="BPML:output">
<assign to="." from="*"></assign>
<assign to="bootstrap">false</assign>
</output>
<input message="input">
<assign to="." from="*"></assign>
</input>
</operation>

</sequence>
</process>

Before Using SendSOAPRequest

Before you use the SendSOAPRequest business process, you must complete the following tasks:

4+ Configure the SOAP Outbound service.
4+ Create a separate business process for each SOAP service you want Application to call.
The business process must complete the following tasks:

¢ Assign a value to SOAPRequestURL. The value is the URL to which Application should post the
SOAP request.

+ Perform an operation with InvokeBusinessProcessService as the participant, assigning
SendSOAPRequest to the WDF_NAME parameter.

4+ Depending on your needs, you may need to assign values to other parameters before using the
SendSOAPRequest business process.

The following table identifies parameters for various SendSOAP functions and the values you must
specify:

Required SOAP Function SOAP Parameter Parameter Value
SOAPAction HTTP header must be SOAP_ACTION Type the HTTP header.
present

SOAP enveloping on primary document ~ ADD_SOAP_ENVELOPING True = add SOAP enveloping (default).

before posting False = no SOAP enveloping.
Digitally sign a SOAP message SIGN_WITH_KEY Type the exact name of the digital
certificate.

Sterling Commerce, Inc. 96



SendSOAPRequest Business Process

Required SOAP Function

SOAP Parameter

Parameter Value

Envelope namespace prefix for SOAP
message

SOAPENVNSPrefix

Type the envelope namespace prefix.
ADD_SOAP_ENVELOPING must also
be true.

Distinguish whether expected response
is a SOAP message

SOAP_RESPONSE_NON_
SOAP

True = response is not a SOAP
message.

False = response is a SOAP message.

Verify a SOAP response that has been
digitally signed

VERIFY_WITH_KEY

Type the name of the public key. Specify
this value before you use the
SendSOAPRequest business process if
you expect a signature on the SOAP
response.

Must use a proxy server

xport-tp-proxyauth

Type the following information in this
format: IP address,port number,user
name,password.

User name and password may not be
required.

Envelope namespace for SOAP
message

SOAPENVNSURI

Type the envelope namespace.
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